
 
 

Manonmaniam Sundaranar University 

Directorate of Distance and 
Continuing Education 

Tirunelveli – 627012, Tamil Nadu. 
 

 

B.A.ECONOMICS 
(First Year) 

 

Computer Applications in Economics 

(JSEC22) 

 

Compiled by 

Dr.K.AJITHA 
Assistant Professor of Economics 

Manonmaniam Sundaranar University 
Tirunelveli – 627 012. 

 

 

 

 



 
 

Subject Experts: 

Dr. D. Amutha 

Associate Professor and Head 

Department of Economics 

S.T. Mary’s College (Autonomous) 

Thoothukudi 

Dr. C. A. Sham Shankar 

Associate Professor and Head 

Department of Economics 

ST. Hindu College 

Nagercoil 

Dr. S. Sarasudevi 

Associate Professor  

Department of Economics 

Rani Anna Government College for Women 

Tirunelveli 

Dr. V. Raja Rajeswari 

Associate Professor  

Department of Economics 

Sri KGS Arts College 

Srivaikundam, Thoothukudi District 

Dr. M. Neeladevi 

Associate Professor 

Department of Economics 

V.O.C College  

Thoothukudi 

Dr. P. Mary Thangam 

Assistant Professor 

Department of Economics 

Sarah Turker College (Autonomous) 

Tirunelveli 

Dr. R. Rajan Babu 

Assistant Professor 

Department of Economics 

ST. Hindu College 

Nagercoil 

Dr. V. Arockia Amuthan 

Assistant Professor 

Department of Economics 

Nazareth Margoschis College 

Pillaiyanmanai, Thoothukudi 

Dr. S. Sasikumar 

Assistant Professor 

Department of Economics 

ST. Xavier’s College (Autonomous) 

Palayamkottai, Tirunelveli 

Dr. G. Gnana Elpinston 

Assistant Professor 

Department of Economics 

Nesamony Memorial Christian College 

Marthandam 

 

Course Coordinator: 

Dr. G. Monikanda Prasad 

 

Course Material Compiled by: 

Dr. K. Ajitha 

Assistant Professor of Economics 

Manonmaniam Sundaranar University 

Tirunelveli – 627 012 

 

 
 

 
 

 



 
 

COMPUTER APPLICATIONS IN ECONOMICS 

Course Objectives: 

1. To know the basic concepts of Computer Applications. 

2. To apply the MS office and its basic operations. 

3. To describes the data processing techniques using various MS office 

operations. 

4. To gain knowledge on application of MS Excel. 

5. To know mathematical and statistical functions for Economic Analysis. 
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UNIT - I 

INTRODUCTION TO COMPUTERS 

1.1 Introduction 

Computer is a machine that performs calculations and processes 

information with astonishing speed and precision. A computer can handle 

vast amounts of information and solve complicated problems. It can take 

thousands of individual pieces of data and turn them into more usable 

information – with blinding speed and almost unfailing accuracy. The most 

powerful computers can perform billions of calculations in a second. A 

computer is a programmable machine. Modern computers are electronic and 

digital. The actual machinery – wires, transistors, and circuits is called 

hardware; the instructions and data are called software. Computers have 

changed the way people work. Computers handle many tasks in business, 

education, manufacturing, transportation, and other fields. 

1.2. Computer and Peripherals: Meaning 

A computer is an electronic device that can receive a set of instruction, 

program and then carry out this program by performing calculations on 

numerical data or by manipulating other forms of information. 

The two principal characteristics of a computer are: 

 It responds to a specific set of instructions in a well-defined manner. 

 It can execute a pre-recorded list of instruction (a program). 

1.3. Types of computers 

Computers come in many forms and sizes, with the capacity to perform 

a variety of applications and designed for use by either a single individual or 

by a large number of users. Once there were two basic types of computers, 

classifies as analog and digital. At present, the categories of computers are 

more specialized forms of the digital computer: computers are generally 

classifies on the basis of operational principle as: 

 Analog computers  

 Digital computers  

 Hybrid computers 

Modern computers are also classified based on the purpose and application 

as: 1. Special Purpose Computer. 2. General Purpose Computers. 
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 The relation between analog, digital, special purpose and general 

purpose computers can be understood only if we know about each of them. 

All analog computers measure continuous types of data and use a physical 

quantity like electric current flow. A digital computer operates and represents 

data in terms of discrete numbers and process data using standard arithmetic 

operations. Special purpose computers are designed to solve specific 

problems. General purpose computers are designed to solve a large variety of 

problems. 

1.3.1 Analog, Digital and Hybrid Computers 

Analog Computers: 

 They represent numbers by a physical quantity, that is, they assign 

nunmeric values by physically measuring some actual property, suchas the 

length of an object, an angle created by two lines, or the amount of voltage 

passing through a point in an electrical circuit. Analog computers derive all 

their data from some form of measurement. Though effective for some 

applications, this method of representing numbers is a limitation of the analog 

computer. The accuracy of the data used in an analog computer is a limitation 

of the analog computer. This accuracy of the data used in an analog computer 

is directly related to the precision of its measurements. 

Digital Computers: 

 They represent data as numbers or separate units. Counting on your 

fingers is the simplest form of digital computer. Each finger represents one 

unit of the item being counted. Unlike the analog computer which is limited 

to the accuracy of the measurements made, the digital computer can 

accurately represent data using as many positions and numbers as 

necessary. Adding machines and pocket calculators are common examples of 

devices constructed on the principles of the digital computer. All feature 

discussions will concentrate on digital computers. Digital computers work in 

highly specialised applications and in a wide range of general processing 

tasks. 

Hybrid computers: 

 They combine the best features of analog and digital computers. They 

have the speed of analog computers and accuracy of digital computers. They 
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are usually used for special problems in which input data derived from 

measurements is converted into digits and processed by computers. Hybrid 

computers, for example, control national defense and passenger flight radar. 

It controls manufacturing and prepares production data on inventory and 

costs. The computer accepts data both from sensors within the production 

area and from conventional input/output (I/O) devices. 

General Purpose and Special Purpose Computers 

Computers are classified on the basis of purpose and application as: 

1. Special Purpose Computer. 2. General Purpose Computers. 

1. Special Purpose Computer: 

 They incorporate many features of general purpose computers but 

support highly specialized data processing tasks. They are designed to handle 

specific problems and are not applied to other computerized activities. For 

example, special purpose computers may be designed to process only numeric 

data or to completely control automated manufacturing processes. Special 

purpose computers are often used as training simulators. A simulator is a 

computer controlled device for training people under simulated, or artificially 

created, conditions. The computer creates test conditions the trainee must 

respond to, records and evaluates the response, and provides results to both 

trainee and supervisor. 

2. General Purpose Computers: 

 They are versatile and process business data as readily as they process 

complex mathematical formulas. General purpose computers can store large 

amounts of data and the programs necessary to process them. Because they 

are so versatile, most business today use general purpose computers. 

 

1.4. CLASSIFICATION OF COMPUTERS: 

 Computers can be classified by their size and power as micro 

computers, workstations, portable computers, minicomputers, mainframes 

and super computers. 

1. Micro Computer: Micro computers are small, single user computer 

based on a microprocessor. In addition to the microprocessor, these 

computers have a keyboard for entering data, a monitor for displaying 
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information, and a storage device for saving data. The micro computers 

are further classified as personal computers, workstations, portable 

computers, etc. 

2. Mini Computer: Minicomputer is a multi-user computer capable of 

supporting ten to hundreds of users simultaneously. 

3. Main Frame Computer: Mainframes are powerful multiuser computers 

capable of supporting many hundreds of users simultaneously. 

Mainframes are mainly used by insurance companies, banks, airline 

and railway reservation systems, etc. 

4. Super Computer: A super computer is an extremely fast computer that 

can perform hundreds of millions of instructions per second. Most 

supercomputers are used by government agencies. These machines are 

for applications requiring very large programs and huge amounts of 

data that must be processed quickly. Examples of such tasks are 

weather forecasting, oil exploration, weapons research, and large scale 

simulation. The difference between a super computer and a mainframe 

is that a supercomputer channels all its power into executing a few 

programs as fast as possible, whereas a mainframe used its powers to 

execute many programs concurrently. 

  

1.5. FEATURES OF COMPUTER 

 All computers have certain common characteristics irrespective of their 

type and size. Computers are not just adding machines; they are capable of 

doing complex activities and operations. They can be programmed to do 

complex, tedious and monotonous tasks. Computers are what they are 

because of the following characteristics. 

1.  Speed 

Executing mathematical calculation, a computer works faster and more 

accurately than human. Computers have the ability to process so many 

millions (1,000,000) of instructions per second. Computer operations are 

performed in micro and nano seconds. A computer is a time saving device. 

It performs several calculations and tasks in few seconds that we take hours 
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to solve. The speed of a computer is measure in terms of Gigahertz and 

Megahertz. 

2. Diligence 

A human cannot work for several hours without resting, yet a computer 

never tires. A computer can conduct millions of calculations per second with 

complete precision without stopping. A computer can consistently and 

accurately do millions of jobs or calculations. There is no weariness or lack 

of concentration. Its memory ability also places it ahead of humans. 

3. Reliability 

A computer is reliable. The output results never differ unless the input 

varies. The output is totally depend on the input. When an input is the same 

the output will also be the same. A computer produces consistent results for 

similar sets of data, if we provide the same set of input at any time we will 

get the same result. 

4. Automation 

The world is quickly moving toward AI (Artificial Intelligence)-based 

technology. A computer may conduct tasks automatically after instructions 

are programmed. By executing jobs automatically, this computer feature 

replaces thousands of workers. Automation in computing is often achieved 

by the use of a program, a script, or batch processing. 

5. Versatility 

Versatility refers to a capacity of computer. Computer perform different 

types of tasks with the same accuracy and efficiency. A computer can 

perform multiple tasks at the same time this is known as versatility. For 

example, while listening to music, we may develop our project 

using PowerPoint and WordPad, or we can design a website. 

6. Memory 

A computer can store millions of records. These records may be accessed 

with complete precision. Computer memory storage capacity is measured in 

Bytes, Kilobytes (KB), Megabytes (MB), Gigabytes (GB), and Terabytes (TB). 

A computer has built-in memory known as primary memory. 

7. Accuracy 
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When a computer performs a computation or operation, the chances 

of errors occurring are low. Errors in a computer are caused by human’s 

submitting incorrect data. A computer can do a variety of operations and 

calculations fast and accurately. 

 

1.6. COMPONENTS OF COMPUTER 

Computer systems consist of three components: Central Processing 

Unit, Input devices and Output devices. Input devices provide data to the 

processor (processing unit), which processes it and generates useful 

information that’s displayed to the user through output devices. Output 

devices are used to show the processed data to the user on computer screen 

or in print form. Below figure depicts the major components of computer 

systems:  

Components of Computer 

1. Central Processing Unit (CPU): 

The Central Processing Unit or CPU is also known as the brain of the 

computer. CPU executes all types of data processing functions. It saves 

data/intermediate results/instructions (program) and controls the operation 

of all parts of the computer. 

Following are the points to remember for Central Processing Unit (CPU): 

 The CPU is taken as the brain of the computer. 

 CPU facilitates all types of data processing operations. 

 It saves data, intermediate results, and instructions (program). 
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 It handles the operating of all parts of the computer. 

 

The CPU itself has the following three components. 

a. Memory or Storage Unit 

b. Control Unit 

c. ALU (Arithmetic Logic Unit) 

a. Memory or Storage Unit 

This part of the computer system works to store instructions, data, and 

intermediate results. This unit passes data to other parts of the computer 

when required. It is also referred to as an internal storage unit or most 

commonly, the main memory or the primary storage or Random Access 

Memory (RAM). It comes in various speeds, power, and capability. Primary 

memory and secondary memory are two important types of memories used in 

the computer system. Responsibilities of the memory unit are: 

Works to store all the data and the instructions required for processing. 

 Works to store intermediate results of processing. 

 Works to store the final results of processing before these results are 

forwarded to an output device. 

 All inputs and outputs are supplied through the main memory. 
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b. Control Unit 

 This unit manages the operations of all parts of the computer but 

does not carry out any calculations or comparisons or actual data processing 

operations. Responsibilities of this unit are: 

 For facilitating the transfer of data and instructions among other units 

of a system. 

 It manages and correlates all the units of the system. 

 It receives the instructions from the memory, interprets them, and 

directs the operation of the system. 

 It interacts with Input/output units to transfer data/results from 

storage. 

 It does not perform processes or store data. 

c. Arithmetic Logic Unit (ALU) 

This unit consists of two subsections namely, 

Arithmetic Section: The responsibility of the arithmetic unit is to execute 

arithmetic operations like addition, subtraction, multiplication, and division. 

A complete set of complex operations are executed by making iterative use of 

the above operations. 

Logic Section: The responsibility of the logic unit is to execute logic 

operations like comparing, selecting, matching, and merging data. 

2. Output Unit: 

This part of the computer encapsulates devices with the help of which 

the user receives the information from the computer. Output devices 

transform the output from the computer into a form understandable by 

the users. Thus, output units generate the data formatted by the computer 

as per users’ interests. Some of the output devices are; Monitor, Printer, 

projector, speakers, headphones, etc. 

3. Input Unit: 

This unit contains devices with the help of which we enter data into the 

computer.  This unit creates a link between the user and the computer. The 

input devices translate the information into a form understandable by the 

computer.  
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1.7. Input and Output devices: 

 An input/output device, often known as an IO device, is any hardware 

that allows a human operator or other systems to interface with a computer. 

Input/output devices, as the name implies, are capable of delivering data 

(output) to and receiving data from a computer (input). An input/output (I/O) 

device is a piece of hardware that can take, output, or process data. It receives 

data as input and provides it to a computer, as well as sends computer data 

to storage media as a storage output. 

1.7.1. Input Devices 

Input devices are the devices that are used to send signals to the computer 

for performing tasks. The receiver at the end is the CPU (Central Processing 

Unit), which works to send signals to the output devices. Some of the 

classifications of Input devices are: 

1. Keyboard Devices 

2. Pointing Devices 

3. Composite Devices 

4. Game Controller 

5. Visual Devices 

6. Audio Input Devices 

Some of the input devices are described below. 

Keyboard devices: 

The keyboard is the most frequent and widely used input device for 

entering data into a computer. Although there are some additional keys for 

performing other operations, the keyboard layout is similar to that of a 

typical typewriter. Generally, keyboards come in two sizes: 84 keys or 

101/102 keys but currently keyboards with 104 keys or 108 keys are also 

available for Windows and the Internet. 

Types of Keys 

 Numeric Keys: It is used to enter numeric data or move the cursor. It 

usually consists of a set of 17 keys. 

 Typing Keys: The letter keys (A-Z) and number keys (09) are among 

these keys. 
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 Control Keys: These keys control the pointer and the screen. There are 

four directional arrow keys on it. Home, End, Insert, Alternate (Alt), 

Delete, Control (Ctrl), etc., and Escape are all control keys (Esc). 

 Special Keys: Enter, Shift, Caps Lock, Number Locks, Tab, etc., and 

Print Screen are among the special function keys on the keyboard. 

 Function Keys: The 12 keys from F1 to F12 are on the topmost row of 

the keyboard. 

Mouse 

The most common pointing device is the mouse. The mouse is used to 

move a little cursor across the screen while clicking and dragging. The cursor 

will stop if you let go of the mouse. The computer is dependent on you to move 

the mouse; it won’t move by itself. As a result, it’s an input device. 

A mouse is an input device that lets you move the mouse on a flat surface to 

control the coordinates and movement of the on-screen cursor/pointer. 

The left mouse button can be used to select or move items, while the right 

mouse button when clicked displays extra menus. 

Joystick 

A joystick is a pointing device that is used to move the cursor on a 

computer screen. A spherical ball is attached to both the bottom and top 

ends of the stick. In a socket, the lower spherical ball slides. You can move 

the joystick in all four directions. The joystick’s function is comparable to 

that of a mouse. It is primarily used in CAD (Computer-Aided Design) and 

playing video games on the computer. 

Track Ball 

Track Ball is an accessory for notebooks and laptops, which works on 

behalf of a mouse. It has a similar structure to a mouse. Its structure is like 

a half-inserted ball and we use fingers for cursor movement. Different 

shapes are used for this like balls, buttons, or squares. 

Light Pen 

A light pen is a type of pointing device that looks like a pen. It can be 

used to select a menu item or to draw on the monitor screen. A photocell and 

an optical system are enclosed in a tiny tube. When the tip of a light pen is 
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moved across a monitor screen while the pen button is pushed, the photocell 

sensor element identifies the screen location and provides a signal to the CPU. 

Scanner 

A scanner is an input device that functions similarly to a photocopier. 

It’s employed when there’s information on paper that needs to be transferred 

to the computer’s hard disc for subsequent manipulation. The scanner 

collects images from the source and converts them to a digital format that 

may be saved on a disc. Before they are printed, these images can be 

modified.  

Optical Mark Reader (OMR) 

An Optical Mark Reader is a device that is generally used in educational 

institutions to check the answers to objective exams. It recognizes the marks 

present by pencil and pen. 

Optical Character Reader (OCR) 

OCR stands for optical character recognition, and it is a device that 

reads printed text. OCR optically scans the text, character by character turns 

it into a machine-readable code, and saves it to the system memory. 

Magnetic Ink Card Reader (MICR) 

It is a device that is generally used in banks to deal with the cheques 

given to the bank by the customer. It helps in reading the magnetic ink 

present in the code number and cheque number. This process is very fast 

compared to any other process. 

Bar Code Reader 

A bar code reader is a device that reads data that is bar-coded (data 

that is represented by light and dark lines).Bar-coded data is commonly used 

to mark things, number books, and so on. It could be a handheld scanner or 

part of a stationary scanner. A bar code reader scans a bar code image, 

converts it to an alphanumeric value, and then sends it to the computer to 

which it is connected. 

Web Camera 

Because a web camera records a video image of the scene in front of it, 

a webcam is an input device. It is either built inside the computer (for 

example, a laptop) or attached through a USB connection. A webcam is a 
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computer-connected tiny digital video camera. It’s also known as a web 

camera because it can take images and record video. These cameras come 

with software that must be installed on the computer in order to broadcast 

video in real-time over the Internet. It can shoot images and HD videos, 

however, the video quality isn’t as good as other cameras (In Mobiles or other 

devices or normal cameras). 

Digitizer 

Digitizer is a device that is used to convert analog signals to digital 

signals. It converts signals into numeric values. An example of a Digitizer is 

Graphic Tablet, which is used to convert graphics to binary data. 

Microphone 

The microphone works as an input device that receives input voice 

signals and also has the responsibility of converting it also to digital form. It 

is a very common device that is present in every device which is related to 

music. 

1.7.2. Output Devices 

Output Devices are the devices that show us the result after giving the 

input to a computer system. Output can be of many different forms like image, 

graphic audio, video, etc. Some of the output devices are described below. 

Monitor 

Monitors, also known as Visual Display Units (VDUs), are a computer’s 

primary output device. It creates images by arranging small dots, known as 

pixels, in a rectangular pattern. The amount of pixels determines the image’s 

sharpness.  

The two kinds of viewing screens used for monitors are described below. 

Cathode-Ray Tube (CRT) Monitor: Pixels are minuscule visual elements 

that make up a CRT display. The higher the image quality or resolution, the 

smaller the pixels. 

Flat-Panel Display Monitor: In comparison to the CRT, a flat-panel 

display is a type of video display with less volume, weight, and power 

consumption. They can be hung on the wall or worn on the wrist. 

Flat-panel displays are currently used in calculators, video games, monitors, 

laptop computers, and graphical displays. 
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Television 

Television is one of the common output devices which is present in each and 

every house. It portrays video and audio files on the screen as the user 

handles the television. Nowadays, we are using plasma displays as compared 

to CRT screens which we used earlier. 

1.7.3. Printers 

Printers are output devices that allow you to print information on paper. 

There are certain types of printers which are described below. 

Impact Printers 

Characters are printed on the ribbon, which is subsequently crushed against 

the paper, in impact printers. The following are the characteristics of impact 

printers: 

 Exceptionally low consumable cost. 

 Quite noisy 

 Because of its low cost, it is ideal for large-scale printing. 

 To create an image, there is physical contact with the paper. 

Types of Impact Printer: 

 Character Printers 

 Line Printers 

 Non-Impact Printers 

 Laser Printers 

 Inkjet Printers 

Character Printers 

Character Printer has the capability to print only one character at a time. It 

is of two types. 

 Dot Matrix Printer 

 Daisy Wheel 

Line Printers 

Line Printers are printers that have the capability to print one line at a time. 

It is of two types. 

 Drum Printer 

 Chain Printer 
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Non-Impact Printers 

Characters are printed without the need for a ribbon in non-impact 

printers. Because these printers print a full page at a time, they’re also known 

as Page Printers. The following are the characteristics of non-impact printers: 

 Faster 

 They don’t make a lot of noise. 

 Excellent quality 

 Supports a variety of typefaces and character sizes 

Laser Printers 

Laser Printers use laser lights for producing dots which will produce 

characters on the page. 

Inkjet Printers 

Inkjet printers are printers that use spray technology for printing 

papers. High-quality papers are produced in an Inkjet printer. They also do 

color printing.  

Speakers 

Speakers are devices that produce sound after getting a command from 

a computer. Nowadays, speakers come with wireless technology also like 

Bluetooth speakers. 

Projector 

Projectors are optical devices that have the work to show visuals on 

both types of screens, stationary and moving both. It helps in displaying 

images on a big screen. Projectors are generally used in theatres, auditoriums, 

etc. 

Plotter 

Plotter is a device that helps in making graphics or other images to give 

a real view. A graphic card is mandatorily required to use these devices. These 

are the pen-like devices that help in generating exact designs on the 

computer. 

Braille Reader 

Braille Reader is a very important device that is used by blind users. It 

helps people with low vision or no vision to recognize the data by running 

their fingers over the device to understand easily. It is a very important device 



15 
 

for blind persons as it gives them the comfort to understand the letters, 

alphabets, etc which helps them in study. 

Video Card 

A video Card is a device that is fitted into the motherboard of the 

computer. It helps in improvising digital content in output devices. It is an 

important tool that helps people in using multiple devices.  

Headphones 

Headphones are just like a speaker, which is generally used by a single 

person or it is a single-person usable device and is not commonly used in 

large areas. These are also called headsets having a lower sound frequency. 

 

1.8. PRIMARY MEMORY AND SECONDARY MEMORY 

Memory is the main component of every system that stores data and 

instructions. A computer's memory is mainly categorized into two types: 

primary and secondary memory. Primary memory is the main memory of the 

system, and it is often random access memory (RAM) and is used to store data 

that the CPU requires quick access to. Secondary memory is the additional 

memory of the system. It is used to store the data that the CPU does not 

require immediate access to, which is typically in the form of hard drives, 

solid-state drives, or detachable storage devices (such as USB drives). 

1.8.1. Define Primary memory 

The primary memory of a PC system is its primary memory. The 

instructions that must be performed at the time are copied to primary memory 

because the CPU may directly access data from the primary memory. 

Accessing data from this memory is faster because it is the internal memory, 

and the CPU accesses data from primary memory via the data bus. 

Primary memory is typically volatile in nature, which implies that information 

in primary memory doesn't exist if the information is not stored in the event 

of a power loss. It is more costly than secondary memory because it is made 

of semiconductors, and primary memory capacity in a computer is restricted 

and is always less than secondary memory. 
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1.8.2. Types of Primary Memory 

RAM (Random Access Memory) and ROM (Read Only Memory) are the two 

types of primary memory. 

1. RAM (Random Access Memory) 

RAM is both a read and writes type of memory. The information that 

has to be currently processed is stored in RAM, which the CPU may 

immediately access. It is a volatile memory that loses data when the electricity 

is turned off. RAM may be static or dynamic in nature. 

2. ROM (Read Only Memory) 

ROM is a read-only memory, which implies that its contents may not 

be altered. It contains the instructions that are executed when the system 

boots up. It is a non-volatile memory, which implies that it preserves its 

contents even after the power is turned off. It has three types of ROM, such 

as PROM, EPROM, and EEPROM. 

1.8.3. Features of Primary Memory 

There are various features of Primary Memory. Some important features of 

Primary Memory are as follows: 

 It is faster to access when compared to secondary memory. 

 If the power is turned off, you may lose data. 

 It is the computer's working memory. 

 It is known as primary memory. 

 Without primary memory, the system cannot function. 

 It is also known to as volatile memory. 

1.8.4. Define Secondary Memory 

Secondary memory is additional computer memory. Secondary memory stores 

data that must be preserved permanently. The CPU cannot directly access 

secondary memory data, and the data must first be copied to primary memory 

before the CPU can process it. As a result, accessing data from secondary 

memory takes longer. The secondary memory may be accessed via the input-

output channel. 

It is non-volatile memory, which implies that its content remains even after 

the power is turned off. It is optical or magnetic memory, which is less 

expensive than primary memory. 
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Secondary memory is always more plentiful than primary memory. As an 

external memory, a computer may even function without secondary memory. 

Secondary memory includes hard disks, CDs, DVDs, floppy disks, etc. 

 

1.8.5. Types of Secondary Memory 

There are various types of secondary memory. Some of them are as follows: 

1. Floppy Disk 

It is a magnetic disk that is enclosed in a square plastic box. Its main 

goal is to store information and then move it from one system to another. 

Floppy disks come in two sizes (1) Size: 3.5 inches, storage capacity: 1.44 MB 

(2) 5.25-inch display and 1.2-MB storage capacity. A system contains a floppy 

disk drive to use a floppy disk. DVDs, CDs, and flash drives have mostly 

replaced this type of storage media. 

2. Hard Disk 

Hard disks are storage devices that may hold a large amount of data. 

Hard disks are often known as hard disk drives. It comes in a range of storage 

capacities (For instance, 256 GB, 500 GB, 1 TB, and 2 TB). It is constructed 

of platters, which are collections of disks. The plates are piled on top of one 

another and covered in a magnetic coating. Each plate is composed of a series 

of invisible circles, each with an identical core track. Hard disks are classified 

into two types: internal and external. 

3. Blu-ray Disk 

It looks like a CD/DVD; however, it may carry up to 25 Gigabytes of 

data. You'll require a Blu-ray reader if you want to utilize a Blu-ray disk. The 

name Blu-ray is derived from the technology that is utilized to read the 

disk: 'Blu' stands for a blue-violet laser, and 'ray' stands for an optical ray. 

4. SD Card 

It is a type of memory card that is often utilized to store data in portable 

devices like cameras and cell phones. It is available in several capacities, such 

as 1, 2, 4, 8, 16, 32, and 64 GB. The data on the SD card can be accessed by 

removing it from the system and placing it into a system through a card 

reader. The SD card data is stored in memory chips, and there are no moving 

parts, as there are on a hard disk. 
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1.8.6. Features of Secondary Memory 

There are various features of Secondary Memory. Some important features of 

Secondary Memory are as follows: 

 These are optical and magnetic memories. 

 It is a sort of non-volatile memory. 

 It aids in the storage of data in a PC. 

 The data is stored permanently, even when the system is turned off. 

 The system can function without secondary memory. 

 It is slower than the primary memory. 

1.9. Computer software: 

1.9.1. Introduction: 

A Computer is an electronic device that can perform various operations of 

computation at a greater speed than what an ordinary machine or human 

mind can do. It is driven by many entities including the physical and tangible 

components that we can touch or feel, called the Hardware and programs and 

commands that drive the hardware, called the Software. The Software refers 

to the set of instructions fed in form of programs to govern the computer 

system and process the hardware components. For example: 

 The antivirus that we use to protect our computer system is a type of 

Software. 

 The media players that we use to play multimedia files such as movies, 

music etc. are Software. 

 The Microsoft Office we use to edit the documents is a Software. 

1.9.2. Definition of software: 

Software is a collection of instructions, data, or computer programs 

that are used to run machines and carry out particular activities. In 

a computer system, the software is basically a set of instructions or 

commands that tell a computer what to do. In other words, the software is a 

computer program that provides a set of instructions to execute a user’s 

commands and tell the computer what to do. For example like MS-Word, MS-

Excel, PowerPoint, etc. 
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1.9.3. Types of Software 

It is a collection of data that is given to the computer to complete a 

particular task. The chart below describes the types of software: Now we will 

briefly describe each type and its subtypes: 

A. System Software 

1. Operating System 

2. Language Processor 

3. Device Driver 

B. Application Software 

1. General Purpose Software 

2. Customize Software 

3. Utility Software 

A. System Software 

System software is software that directly operates the computer 

hardware and provides the basic functionality to the users as well as to the 

other software to operate smoothly. Or in other words, system software 

basically controls a computer’s internal functioning and also controls 

hardware devices such as monitors, printers, and storage devices, etc. It is 

https://www.geeksforgeeks.org/computer-hardware/
https://www.geeksforgeeks.org/computer-hardware/
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like an interface between hardware and user applications, it helps them to 

communicate with each other because hardware understands machine 

language(i.e. 1 or 0) whereas user applications are work in human-readable 

languages like English, Hindi, German, etc. so system software converts the 

human-readable language into machine language and vice versa. 

Types of System Software 

It has two subtypes which are: 

Operating System: It is the main program of a computer system. When the 

computer system ON it is the first software that loads into the computer’s 

memory. Basically, it manages all the resources such as computer 

memory, CPU, printer, hard disk, etc., and provides an interface to the user, 

which helps the user to interact with the computer system. It also provides 

various services to other computer software. Examples of operating systems 

are Linux, Apple Mac OS, Microsoft Windows, etc. 

Language Processor: As we know that system software converts the human-

readable language into a machine language and vice versa. So, the conversion 

is done by the language processor. It converts programs written in high-

level programming languages like Java, C, C++, Python, etc (known as source 

code), into sets of instructions that are easily readable by machines(known as 

object code or machine code). 

Device Driver: A device driver is a program or software that controls a device 

and helps that device to perform its functions. Every device like a printer, 

mouse, modem, etc. needs a driver to connect with the computer system 

eternally. So, when you connect a new device with your computer system, first 

you need to install the driver of that device so that your operating system 

knows how to control or manage that device. 

Features of System Software 

Let us discuss some of the features of System Software: 

 System Software is closer to the computer system. 

 System Software is written in a low-level language in general. 

 System software is difficult to design and understand. 

 System software is fast in speed (working speed). 

https://www.geeksforgeeks.org/computer-memory/
https://www.geeksforgeeks.org/computer-memory/
https://www.geeksforgeeks.org/central-processing-unit-cpu/
https://www.geeksforgeeks.org/what-is-a-printer/
https://www.geeksforgeeks.org/introduction-to-linux-operating-system/
https://www.geeksforgeeks.org/interesting-facts-about-windows/
https://www.geeksforgeeks.org/introduction-to-programming-languages/
https://www.geeksforgeeks.org/introduction-to-java/
https://www.geeksforgeeks.org/c-plus-plus/
https://www.geeksforgeeks.org/c-plus-plus/
https://www.geeksforgeeks.org/history-of-python/
https://www.geeksforgeeks.org/how-to-install-a-modem/
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 System software is less interactive for the users in comparison to 

application software. 

B. Application Software  

Software that performs special functions or provides functions that are 

much more than the basic operation of the computer is known as application 

software. Or in other words, application software is designed to perform a 

specific task for end-users. It is a product or a program that is designed only 

to fulfill end-users’ requirements. It includes word processors, spreadsheets, 

database management, inventory, payroll programs, etc. 

Types of Application Software 

There are different types of application software and those are: 

General Purpose Software: This type of application software is used for a 

variety of tasks and it is not limited to performing a specific task only. For 

example, MS-Word, MS-Excel, PowerPoint, etc. 

Customized Software: This type of application software is used or designed 

to perform specific tasks or functions or designed for specific organizations. 

For example, railway reservation system, airline reservation system, invoice 

management system, etc. 

Utility Software: This type of application software is used to support the 

computer infrastructure. It is designed to analyze, configure, optimize and 

maintains the system, and take care of its requirements as well. For 

example, antivirus, disk fragmenter, memory tester, disk repair, disk 

cleaners, registry cleaners, disk space analyzer, etc. 

Features of Application Software 

Let us discuss some of the features of Application Software: 

 An important feature of application software is it performs more 

specialized tasks like word processing, spreadsheets, email, etc. 

 Mostly, the size of the software is big, so it requires more storage space. 

 Application software is more interactive for the users, so it is easy to 

use and design. 

 The application software is easy to design and understand. 

 Application software is written in a high-level language in general. 

 

https://www.geeksforgeeks.org/what-is-application-software/
https://www.geeksforgeeks.org/what-is-application-software/
https://www.geeksforgeeks.org/introduction-to-excel-spreadsheet/
https://www.geeksforgeeks.org/railway-reservation-system-in-c/
https://www.geeksforgeeks.org/how-an-antivirus-works/
https://www.geeksforgeeks.org/what-is-an-email/
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1.10. MALICIOUS SOFTWARE 

Any malicious software intended to harm or exploit any programmable 

device, service, or network is referred to as malware. Cybercriminals 

typically use it to extract data they can use against victims to their advantage 

in order to profit financially. Financial information, medical records, 

personal emails, and passwords are just a few examples of the types of 

information that could be compromised. 

In simple words, malware is short for malicious software and refers to any 

software that is designed to cause harm to computer systems, networks, or 

users. Malware can take many forms. It’s important for individuals and 

organizations to be aware of the different types of malware and take steps to 

protect their systems, such as using antivirus software, keeping software 

and systems up-to-date, and being cautious when opening email 

attachments or downloading software from the internet. 

Malware is a program designed to gain access to computer systems, 

generally for the benefit of some third party, without the user’s permission. 

Malware includes computer viruses, worms, Trojan horses, ransom ware, 

spyware, and other malicious programs. 

1.10.1 . Types of Malware 

1. Viruses – A Virus is a malicious executable code attached to another 

executable file. The virus spreads when an infected file is passed from 

system to system. Viruses can be harmless or they can modify or delete 

data. Opening a file can trigger a virus. Once a program virus is active, 

it will infect other programs on the computer. 

2. Worms – Worms replicate themselves on the system, attaching 

themselves to different files and looking for pathways between 

computers, such as computer network that shares common file 

storage areas. Worms usually slow down networks. A virus needs a 

host program to run but worms can run by themselves. After 

a worm affects a host, it is able to spread very quickly over the 

network. 

3. Trojan horse – A Trojan horse is malware that carries out malicious 

operations under the appearance of a desired operation such as 
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playing an online game. A Trojan horse varies from a virus because 

the Trojan binds itself to non-executable files, such as image files, and 

audio files. 

4. Ransom ware – Ransom ware grasps a computer system or the data 

it contains until the victim makes a payment. Ransom ware encrypts 

data in the computer with a key that is unknown to the user. The user 

has to pay a ransom (price) to the criminals to retrieve data. Once the 

amount is paid the victim can resume using his/her system 

5. Adware – It displays unwanted ads and pop-ups on the computer. It 

comes along with software downloads and packages. It generates 

revenue for the software distributer by displaying ads. 

6. Spyware – Its purpose is to steal private information from a computer 

system for a third party. Spyware collects information and sends it to 

the hacker. 

7. Logic Bombs – A logic bomb is a malicious program that uses a trigger 

to activate the malicious code. The logic bomb remains non-

functioning until that trigger event happens. Once triggered, a logic 

bomb implements a malicious code that causes harm to a computer. 

Cyber security specialists recently discovered logic bombs that attack 

and destroy the hardware components in a workstation or server 

including the cooling fans, hard drives, and power supplies. The logic 

bomb overdrives these devices until they overheat or fail. 

8. Rootkits – A rootkit modifies the OS to make a backdoor. Attackers 

then use the backdoor to access the computer distantly. Most rootkits 

take advantage of software vulnerabilities to modify system files. 

9. Backdoors – A backdoor bypasses the usual authentication used to 

access a system. The purpose of the backdoor is to grant cyber 

criminals future access to the system even if the organization fixes the 

original vulnerability used to attack the system. 

1.10.2. Protect From Malware 

The good news is that there are just as many ways to protect yourself from 

malware as there are different types of malware.  

 Protect your devices. 
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 Update your operating system and software. Install updates as soon 

as they become available because cybercriminals search for 

vulnerabilities in out-of-date or outdated software. 

 Never click on a popup’s link. Simply click the “X” in the message’s 

upper corner to close it and leave the page that generated it. 

 Don’t install too many apps on your devices. Install only the apps you 

believe you will regularly use and need. 

 Be cautious when using the internet. 

 Do not click on unidentified links. If a link seems suspicious, avoid 

clicking it whether it comes from an email, social networking site, or 

text message. 

 Choose the websites you visit wisely. Use a safe search plug-in and try 

to stick to well-known and reputable websites to avoid any that might 

be malicious without your knowledge. 

 Emails requesting personal information should be avoided. Do not 

click a link in an email that appears to be from your bank and asks 

you to do so in order to access your account or reset your password. 

Log in immediately at your online banking website. 

1.10.3. Remove Malware 

 A large number of security software programs are made to both find 

and stop malware as well as to eliminate it from infected systems. 

An antimalware tool that handles malware detection and removal is malware 

bytes. Malware can be eliminated from Windows, macOS, Android, and iOS 

operating systems. A user’s registry files, currently running programs, hard 

drives, and individual files can all be scanned by Malware bytes. Malware 

can then be quarantined and removed if it is found. Users cannot, however, 

set automatic scanning schedules like they can with some other tools. 

Advantages of Detecting and Removing Malware 

1. Improved Security: By detecting and removing malware, individuals, 

and organizations can improve the security of their systems and 

reduce the risk of future infections. 
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2. Prevent Data Loss: Malware can cause data loss, and by removing it, 

individuals and organizations can protect their important files and 

information. 

3. Protect Reputation: Malware can cause harm to a company’s 

reputation, and by detecting and removing it, individuals and 

organizations can protect their image and brand. 

4. Increased Productivity: Malware can slow down systems and make 

them less efficient, and by removing it, individuals and organizations 

can increase the productivity of their systems and employees. 

Disadvantages of Detecting and Removing Malware 

1. Time-Consuming: The process of detecting and removing malware can 

be time-consuming and require specialized tools and expertise. 

2. Cost: Antivirus software and other tools required to detect and remove 

malware can be expensive for individuals and organizations. 

3. False Positives: Malware detection and removal tools can sometimes 

result in false positives, causing unnecessary alarm and inconvenience. 

4. Difficulty: Malware is constantly evolving, and the process of detecting 

and removing it can be challenging and require specialized knowledge 

and expertise. 

5. Risk of Data Loss: Some malware removal tools can cause unintended 

harm, resulting in data loss or system instability. 

 

1.11. OPERATING SYSTEMS: 

Operating System lies in the category of system software. It basically 

manages all the resources of the computer. An operating system acts as an 

interface between the software and different parts of the computer or the 

computer hardware. The operating system is designed in such a way that it 

can manage the overall resources and operations of the computer. Operating 

System is a fully integrated set of specialized programs that handle all the 

operations of the computer. It controls and monitors the execution of all 

other programs that reside in the computer, which also includes application 

programs and other system software of the computer. Examples of Operating 

Systems are Windows, Linux, Mac OS, etc. An Operating System (OS) is a 
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collection of software that manages computer hardware resources and 

provides common services for computer programs. The operating system is 

the most important type of system software in a computer system. 

The operating system helps in improving the computer software as well 

as hardware. Without OS, it became very difficult for any application to be 

user-friendly. The Operating System provides a user with an interface that 

makes any application attractive and user-friendly. The operating System 

comes with a large number of device drivers that make OS services reachable 

to the hardware environment. Each and every application present in the 

system requires the Operating System. The operating system works as a 

communication channel between system hardware and system software. The 

operating system helps an application with the hardware part without 

knowing about the actual hardware configuration. It is one of the most 

important parts of the system and hence it is present in every device, 

whether large or small device. 

1.11.1. Functions of the Operating System 

 Resource Management: The operating system manages and allocates 

memory, CPU time, and other hardware resources among the various 

programs and processes running on the computer. 

 Process Management: The operating system is responsible for 

starting, stopping, and managing processes and programs. It also 

controls the scheduling of processes and allocates resources to them. 

 Memory Management: The operating system manages the computer’s 

primary memory and provides mechanisms for optimizing memory 

usage. 

 Security: The operating system provides a secure environment for the 

user, applications, and data by implementing security policies and 

mechanisms such as access controls and encryption. 

 Job Accounting: It keeps track of time and resources used by various 

jobs or users. 

 File Management: The operating system is responsible for organizing 

and managing the file system, including the creation, deletion, and 

manipulation of files and directories. 
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 Device Management: The operating system manages input/output 

devices such as printers, keyboards, mice, and displays. It provides 

the necessary drivers and interfaces to enable communication between 

the devices and the computer. 

 Networking: The operating system provides networking capabilities 

such as establishing and managing network connections, handling 

network protocols, and sharing resources such as printers and files 

over a network. 

 User Interface: The operating system provides a user interface that 

enables users to interact with the computer system. This can be 

a Graphical User Interface (GUI), a Command-Line Interface (CLI), or 

a combination of both. 

 Backup and Recovery: The operating system provides mechanisms 

for backing up data and recovering it in case of system failures, errors, 

or disasters. 

 Virtualization: The operating system provides virtualization 

capabilities that allow multiple operating systems or applications to 

run on a single physical machine. This can enable efficient use of 

resources and flexibility in managing workloads. 

 Performance Monitoring: The operating system provides tools for 

monitoring and optimizing system performance, including identifying 

bottlenecks, optimizing resource usage, and analyzing system logs and 

metrics. 

 Time-Sharing: The operating system enables multiple users to share 

a computer system and its resources simultaneously by providing 

time-sharing mechanisms that allocate resources fairly and efficiently. 

 System Calls: The operating system provides a set of system calls that 

enable applications to interact with the operating system and access 

its resources. System calls provide a standardized interface between 

applications and the operating system, enabling portability and 

compatibility across different hardware and software platforms. 
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 Error-detecting Aids: These contain methods that include the 

production of dumps, traces, error messages, and other debugging and 

error-detecting methods. 

 

1.11.2. Types of Operating Systems 

There are several types of Operating Systems which are mentioned below 

1. Batch Operating System 

2. Multi-Programming System 

3. Multi-Processing System 

4. Multi-Tasking Operating System 

5. Time-Sharing Operating System 

6. Distributed Operating System 

7. Network Operating System 

1. Batch Operating System:- 

This type of operating system does not interact with the computer 

directly. There is an operator which takes similar jobs having the same 

requirement and groups them into batches. It is the responsibility of the 

operator to sort jobs with similar needs.  

Advantages of Batch Operating System:-  

 The system accepts the various jobs from the user and place them in 

queue for getting CPU time. Processors of the batch systems know how 

long the job would be when it is in the queue. 

 Multiple users can share the batch systems. 

 The idle time for the batch system is very less. 

 It is easy to manage large work repeatedly in batch systems. 

Disadvantages of Batch Operating System:- 

 The computer operators should be well known with batch systems. 

 Batch systems are hard to debug. 

 It is sometimes costly. 

 The other jobs will have to wait for an unknown time if any job fails. 

 Examples of Batch Operating Systems: Payroll Systems, Bank 

Statements, etc.  

2. Multi-Programming Operating System 
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Multiprogramming Operating Systems can be simply illustrated as 

more than one program is present in the main memory and any one of them 

can be kept in execution. This is basically used for better execution of 

resources. 

Advantages of Multi-Programming Operating System 

 Multi Programming increases the Throughput of the System. 

 It helps in reducing the response time. 

Disadvantages of Multi-Programming Operating System 

 There is not any facility for user interaction of system resources with 

the system. 

3. Multi-Processing Operating System 

Multi-Processing Operating System is a type of Operating System in 

which more than one CPU is used for the execution of resources. It betters 

the throughput of the System. 

Advantages of Multi-Processing Operating System 

 It increases the throughput of the system. 

 As it has several processors, so, if one processor fails, we can proceed 

with another processor. 

Disadvantages of Multi-Processing Operating System 

 Due to the multiple CPU, it can be more complex and somehow difficult 

to understand. 

4. Multi-Tasking Operating System 

Multitasking Operating System is simply a multiprogramming 

Operating System with having facility of a Round-Robin Scheduling 

Algorithm. It can run multiple programs simultaneously. 

There are two types of Multi-Tasking Systems which are listed below. 

 Pre-emptive Multi-Tasking 

 Cooperative Multi-Tasking 

Advantages of Multi-Tasking Operating System 

 Multiple Programs can be executed simultaneously in Multi-Tasking 

Operating System. 

 It comes with proper memory management. 

Disadvantages of Multi-Tasking Operating System 
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 The system gets heated in case of heavy programs multiple times. 

5. Time-Sharing Operating Systems 

Each task is given some time to execute so that all the tasks work 

smoothly. Each user gets the time of the CPU as they use a single system. 

These systems are also known as Multitasking Systems. The task can be from 

a single user or different users also. The time that each task gets to execute 

is called quantum. After this time interval is over OS switches over to the next 

task.  

Advantages of Time-Sharing OS 

 Each task gets an equal opportunity. 

 Fewer chances of duplication of software. 

 CPU idle time can be reduced. 

 Resource Sharing: Time-sharing systems allow multiple users to share 

hardware resources such as the CPU, memory, and peripherals, 

reducing the cost of hardware and increasing efficiency. 

 Improved Productivity: Time-sharing allows users to work 

concurrently, thereby reducing the waiting time for their turn to use the 

computer. This increased productivity translates to more work getting 

done in less time. 

 Improved User Experience: Time-sharing provides an interactive 

environment that allows users to communicate with the computer in 

real time, providing a better user experience than batch processing. 

Disadvantages of Time-Sharing OS 

 Reliability problem. 

 One must have to take care of the security and integrity of user 

programs and data. 

 Data communication problem. 

 High Overhead: Time-sharing systems have a higher overhead than 

other operating systems due to the need for scheduling, context 

switching, and other overheads that come with supporting multiple 

users. 
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 Complexity: Time-sharing systems are complex and require advanced 

software to manage multiple users simultaneously. This complexity 

increases the chance of bugs and errors. 

 Security Risks: With multiple users sharing resources, the risk of 

security breaches increases. Time-sharing systems require careful 

management of user access, authentication, and authorization to 

ensure the security of data and software. 

Examples of Time-Sharing OS with explanation 

IBM VM/CMS: IBM VM/CMS is a time-sharing operating system that was 

first introduced in 1972. It is still in use today, providing a virtual machine 

environment that allows multiple users to run their own instances of 

operating systems and applications. 

TSO (Time Sharing Option): TSO is a time-sharing operating system that 

was first introduced in the 1960s by IBM for the IBM System/360 mainframe 

computer. It allowed multiple users to access the same computer 

simultaneously, running their own applications. 

6. Distributed Operating System 

These types of operating system is a recent advancement in the world 

of computer technology and are being widely accepted all over the world and, 

that too, at a great pace. Various autonomous interconnected computers 

communicate with each other using a shared communication network. 

Independent systems possess their own memory unit and CPU. These are 

referred to as loosely coupled systems or distributed systems. These systems’ 

processors differ in size and function. The major benefit of working with these 

types of the operating system is that it is always possible that one user can 

access the files or software which are not actually present on his system but 

some other system connected within this network i.e., remote access is 

enabled within the devices connected in that network.  

Advantages of Distributed Operating System 

 Failure of one will not affect the other network communication, as all 

systems are independent of each other. 

 Electronic mail increases the data exchange speed. 
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 Since resources are being shared, computation is highly fast and 

durable. 

 Load on host computer reduces. 

 These systems are easily scalable as many systems can be easily added 

to the network. 

 Delay in data processing reduces. 

Disadvantages of Distributed Operating System 

 Failure of the main network will stop the entire communication. 

 To establish distributed systems the language is used not well-defined 

yet. 

 These types of systems are not readily available as they are very 

expensive. Not only that the underlying software is highly complex and 

not understood well yet. 

7. Network Operating System 

These systems run on a server and provide the capability to manage 

data, users, groups, security, applications, and other networking functions. 

These types of operating systems allow shared access to files, printers, 

security, applications, and other networking functions over a small private 

network. One more important aspect of Network Operating Systems is that all 

the users are well aware of the underlying configuration, of all other users 

within the network, their individual connections, etc. and that’s why these 

computers are popularly known as tightly coupled systems. 

Advantages of Network Operating System  

 Highly stable centralized servers. 

 Security concerns are handled through servers. 

 New technologies and hardware up-gradation are easily integrated into 

the system. 

 Server access is possible remotely from different locations and types of 

systems. 

Disadvantages of Network Operating System  

 Servers are costly. 

 User has to depend on a central location for most operations. 

 Maintenance and updates are required regularly. 
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 Examples of Network Operating Systems are Microsoft Windows Server 

2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell 

NetWare, BSD, etc.  

 

1.12. Limitations of computers: 

 Virus and hacking attacks: A virus may be a worm and hacking 

is just unauthorized access over a computer for a few illicit 

purposes. Viruses can go to another system from email 

attachments, viewing an infected website advertisement, through 

removable devices like USBs etc. 

 Online Cyber Crimes: Online cybercrime means computers and 

networks may have been utilized in order to commit a crime. 

 High cost: Computers are expensive. Even the foremost 

affordable computers are still very expensive. 

 Health problems: Prolonged use of computers can lead to 

various health hazards. Too much sitting near the screen results 

in eye strain and drying up of the eyes.  

 Inadequate Intelligence: A computer is an artificial mechanism 

or object lacking the same intelligence level as humans. They 

behave as programmed machines that rely primarily on the input 

we provide. They cannot make any logical decisions 

independently due to their lack of intelligence, which is defined 

by this. 

 Power Dependency: A power supply is necessary for the desktop 

computer to turn on and perform fully. The PC greatly depends 

on electricity to carry out its essential functions. 

Conclusion: 

 Computers have unleashed a world of possibilities, offering immense 

advantages such as lightning fast processing, vast storage capabilities, and 

automation of tasks and wealth of information. They including health issues, 

security risks, job displacement and privacy concerns. 
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Check Your Progress: 

Q.No                                        Short Questions                                           LOCF Mapping     

1. 

2. 

3. 

4. 

5. 

Explain the meaning and importance of computer peripherals. 

Identify the functions of an operating system. 

Describe the basic components of a computer system. 

Demonstrate central processing unit. 

Recall the various input devices used in computers. 

K2 

K6 

K1 

K2 

K5 

CO1 

CO2 

CO3 

CO4 

CO2 

PO1 

PO5 

PO1 

PO1 

PO4 

Q.No                                        Essay Type Questions                                LOCF Mapping 

1. 

2. 

3. 

 

4. 

 

5. 

Explain the classification and functions of computer software. 

Analyze the impact of malicious software on computer systems. 

Distinguish between primary memory and secondary memory 

with suitable examples. 

Evaluate the importance of security measures against malicious 

software. 

Elaborately discuss the role of operating systems in modern 

computing environments. 

K1 

K3 

K5 

 

K5 

 

K2 
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UNIT – II 

MS OFFICE 

1.1. Introduction 

Microsoft word is a word processor software developed by Microsoft in 

1983. It is the most commonly used word processor software. It is used to 

create professional quality documents, letters, reports, resumes, etc. and also 

allows you to edit or modify your new or existing document. The file saved in 

Ms Word has .docx extension. It is a component of the Microsoft Office suite, 

but you can buy it separately and is available for both Windows and macOS.  

2.2. WINDOWS EXPLORER 

Microsoft Windows File Explorer is a graphical file management utility 

for the Windows operating system (OS). Windows Explorer was introduced 

with Windows 95 and later renamed File Explorer. Each time a computer user 

accesses a disk or opens a folder containing files, they are using the Windows 

File Explorer utility. Windows Explorer took on the File Explorer name in 2012 

with the release of Windows 8 and Windows Server 2012. The file manager 

application's graphical user interface includes a toolbar and a file operation 

dialog that displays more detailed options. 

How does File Explorer work? 

The goal of the file management utility is to let users conveniently work 

with the files and directories on any connected disk. Users open Windows File 

Explorer by clicking the File Explorer icon on the taskbar or from the Start 

menu. When a file is selected in the File Explorer interface, users can select 

from numerous context-aware actions such as renaming, moving, copying, 

publishing, emailing, printing and deleting the file. Entire folders can be 

opened, explored, shared, copied, cut, pasted, moved and deleted. Files can 

be searched, users can drag and drop them between folders, and folders can 

be moved into other folders and disk drives. 

Windows File Explorer can present files and folders in several formats 

such as thumbnail image arrays, icons, lists and details, including name, size, 

type, date and time. The choice of display format depends on the user's 

preferences and type of content being explored. A folder with an extensive 

https://www.techtarget.com/whatis/definition/operating-system-OS
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library of image, video or music file types might be displayed in thumbnail 

format, while a folder of documents might be viewed as a detailed list. 

How is File Explorer organized? 

File Explorer in Windows 10 is divided into three main sections on a graphical 

toolbar that's divided into following three tabs: 

Home tab. Windows 10 displays the toolbar's Home tab by default. It contains 

general-purpose icons for basic functions, such as copy, paste, move to, 

rename and properties. 

Share tab. Windows 10 File Explorer's Share tab contains icons providing 

options for sharing a selected item with others. They let users e-mail, print or 

fax an item or even burn it to disk. 

View tab. The toolbar's View tab is used to customize File Explorer's 

appearance. View options include extra-large icons, large icons, medium 

icons, small icons, list, details, tiles or content. The View tab can be used to 

display or hide filename extensions, item checkboxes and hidden items. It 

contains options for viewing and hiding the navigation, preview and details 

panes. 

The second of Windows 10 File Explorer's three areas is the navigation pane. 

It's displayed along the left side of the interface in a tree-like view. It 

exposes network drives and their folders and libraries, such as the desktop, 

documents, downloads, music, pictures and videos libraries. The navigation 

pane can also contain quick-access shortcuts to commonly used folders. 

The third area of the Windows File Explorer interface displays the files and 

folders in the currently selected location. From here, a user can navigate the 

file system, double click on a file to open it and right-click on a file to access 

a context-sensitive menu with options such as share, open with, send to or 

properties. 

The File Explorer interface can appear differently depending on which item is 

selected. For example, clicking on the This PC icon found in the navigation 

pane causes File Explorer to display the computer's libraries, devices and 

drives, and network locations. For each local drive and mapped network drive, 

File Explorer displays a graphical view of the drive's total capacity and space 

remaining. This view replaces the toolbar's Home tab with a Computer tab 
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that provides options to access media, map network drives, add a network 

location, open settings and uninstall or change programs. The Share tab 

doesn't exist when This PC is selected. 

File Explorer in Windows 11 has a simplified toolbar that replaces the 

Windows 10 File Explorer ribbon. It uses icons to provide much the same 

basic functionality, however, and its tabs simplify file organizing and toggling 

among folders. Windows 11 File Explorer's right-click menu also has changed; 

it uses icons for the cut, copy, paste, rename and delete functions rather than 

the words. 

2.3. MS Word: Basic operations in word 

Microsoft word is a word processor software developed by Microsoft in 

1983. It is the most commonly used word processor software. It is used to 

create professional quality documents, letters, reports, resumes, etc and also 

allows you to edit or modify your new or existing document. The file saved in 

Ms Word has .docx extension. It is a component of the Microsoft Office suite, 

but you can buy it separately and is available for both Windows and macOS. 

The latest version of Ms Word is 2019.  

2.3.1. How to open MS Word? 

The following step shows how to open MS words:  

Step 1: Type Ms Word in the search bar. 
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Step 2: Select Ms Word application. 

Step 3: Select a blank document and press create button. 

Then you will get a window like in the image below where you can write your 

content and perform different types of operations on that content, like font 

type, style, bold, italic, etc. You can also add images, tables, charts to your 

document. Then you will get a window like in the image below where you can 

write your content and perform different types of operations on that content, 

like font type, style, bold, italic, etc. You can also add images, tables, charts 

to your document. 
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2.3.2. Features of Micro Soft Word 

Now let us discuss the features or components of the Ms Word. Using these 

features, you can perform different types of operations on your documents, 

like you can create, delete, and style, modify, or view the content of your 

document.  

1. File 

It contains options related to the file, like New (used to create a new 

document), Open (used to open an existing document), Save (used to save 

document), Save As(used to save documents), History, Print,  Share, Export, 

Info, etc. 

 

2. Home 

It is the default tab of Ms Word and it is generally divided into five groups, 

i.e., Clipboard, Font, Paragraph, Style and Editing. It allows you to select the 

color, font, emphasis, bullets, and position of your text. It also contains 
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options like cut, copy, and paste. After selecting the home tab you will get 

below options: 

3. Insert 

It is the second tab present on the menu bar or ribbon. It contains various 

items that you may want to insert into a Microsoft word. It includes options 

like tables, word art, hyperlinks, symbols, charts, signature line, date and 

time, shapes, header, footer, text boxes, links, boxes, equations, etc., as 

shown in the below image: 

 

4. Draw 

It is the third tab present in the menu bar or ribbon. It is used for freehand 

drawing in Ms Word. It provides different types of pens for drawing as shown 

below: 

 

5. Design 

It is the fourth tab present in the menu bar or ribbon. The design tab contains 

document designs that you can select, such as documents with centered 
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titles, offset headings, left-justified text, page borders, watermarks, page 

color, etc., as shown in the below image:  

 

6. Layout 

It is the fifth tab present on the menu bar or ribbon. It holds all the options 

that allow you to arrange your Microsoft Word document pages just the way 

you want them. It includes options like set margins, display line numbers, set 

paragraph indentation, and lines apply themes, control page orientation and 

size, line breaks, etc., as shown in the below image:  

 

7. References 

It is the sixth tab present in the menu bar or ribbon. The references tab 

lets you add references to a document, then create a bibliography at the end 

of the text. The references are generally stored in a master list, which is used 

to add references to further documents. It includes options like, Table of 

Contents, Footnotes, Citations & Bibliography, Captions, Index, Table of 

Authorities, smart look, etc. After selecting References tab, you will get the 

below options: 
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8. Mailings 

It is the seventh tab present in the menu bar or ribbon. It is a least used tab 

in the menu bar. This tab is where you would create labels, print them on 

envelopes, do mail merge, etc. After selecting mailing, you will get the below 

options: 

 

9. Review 

It is the eighth tab present in the menu bar or ribbon. The review tab contains, 

commenting, language, translation, spell check, word count tools. It is good 

for quickly locating and editing comments. After selecting a review tab, you 

will get the options below: 
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10. View 

It is the ninth tab present in the menu bar or ribbon. View tab allows you to 

switch between single page or double page and also allows you to control the 

layout tools It includes print layout, outline, web layout, task pane, toolbars, 

ruler, header and footer, footnotes, full-screen view, zoom, etc. as shown in 

the below image: 

 

2.4. Formatting in MS Word 

In MS Word there are multiple types of formatting we can apply to a 

given text such as Fonts, Font Styles, Font Colors, Font Sizes, Text Highlight 

Colors, Clearing Formats, Change Cases, etc. Let us apply these techniques 

to some texts in the Word Processor and see what result it produces. 

1. Font 

Fonts are used to change the display of the text or Word Document, 

look more appealing, and as per the requirement of the situation. There are 
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multiple types of fonts available in MS Word-like: Calibri, Times New 

Roman, Algerian, Arial, Century, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the font of. 

Step 2: Now, select the font of your choice from the Home menu bar in MS 

Word. 

 

2. Font Style 

Font Styles are used to change the Look ability of the text or give more 

emphasis on some texts in the Word Document. There are three types of font 

styles in MS Word: Bold, Italics, and Underline. 

Steps to Apply Bold Font Style: 

Step 1: Select the text you want to change the Font Style. 

Step 2: Now, select the Font Style of your choice from the Font Style bar 

under the Home menu bar.  
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Steps to Apply Italics Font Style: 

Step 1: Now, select the Font Style of your choice from the Font Style bar 

under the Home menu bar.  

 

Steps to Apply Underline Font Style: 

Step 1: Now, select the Font Style of your choice from the Font Style bar 

under the Home menu bar. 

 

3. Font Color 

Font Colors have wide use in real life when using the Word Document. 

Be it highlighting the main points of the document or want to convey some 

important information. There are multiple types of Font Colors available in 

MS Word-like: Red, Blue, Yellow, and Orange, Light blue, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the Font Color. 

Step 2: Now, select the Font Color of your choice from the Font Color bar 

under the Home menu bar. 
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4. Font Size 

Font Sizes are used to display the text in the Word Document larger 

or smaller according to our needs. We generally display a heading with a 

Font Size of 15, Subheadings with a Font Size of 14 or 13, and paragraphs 

with a Font Size of 12. Many Font Sizes are available in MS Word-like: 8, 9, 

10, 11, 12, 14, 16, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the Font Size. 

Step 2: Now, select the Font Size of your choice from the Font Size bar under 

the Home menu bar. 

5. Text Highlight Color 

As the name itself suggests, the text highlight Color is used to highlight 

text in the Word Document. There are many Text Highlight Colors available 

in MS Word-like: Yellow, Bright Green, Turquoise, Pink, Red, etc. 

Steps to Apply: 

Step 1: Select the text you want to change the Highlight Colors. 

Step 2: Now, select the Color of your choice from the Text Highlight Color bar 

under the Home menu bar. 
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6. Clear Formats 

MS Word provides a feature to clear the pre-formatted text. When we 

copy some text or information from somewhere it has some formatting 

applied already, so to remove it and use it according to our need in our Word 

Document we have to clear the Formatting. 

Steps to Apply: 

Step 1: Select the text you want to clear the formatting. 

Step 2: Now, select the Clear All Formatting bar under the Home menu bar. 

 

7. Change Case 

Change Case is used to display the text in the way we want in our 

Word Document. There are five types of Change Cases available in MS Word-

like: Sentence case, Lowercase, Uppercase, Capitalize each word, and toggle 

case. 

Steps to Apply: 

Step 1: Select the text you want to change the Case. 

Step 2: Now, select the case of your choice from the Change Case bar under 

the Home menu bar. 
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2.5. Text Creation of Tables and Volumes 

Microsoft Word or MS-WORD is a graphical word processing program 

that users can type with. It allows the users to type and save documents very 

similar to other word processors. There are many versions of MS-word in 

market, which the user can install as per te. In this tutorial, we will learn 

about the tables in MS-Word.  

Tables in MS Word are made up of rows and columns with an organized 

arrangement of text. These tables can be used to align numbers in columns 

and then various operations can be performed on them. Tables can also be 

used to create page layouts. Rows in a table are series of data banks laid out 

horizontally in a table or spreadsheet. Columns are vertical series of cells in 

a chart, table, or spreadsheet. 

Create a Table 

Tables in MS Word can be created in the following two ways: 

1. Using the Grid 

2. Using Table Dialogue Box 

1. Using the Grid 

Following are the steps of creating a table using the Grid provided in MS Word: 

Step 1: Go to the Insert tab and click on the Table button. 

 

Step 2: In the dropdown menu, select the number of rows and columns from 

the Grid. 
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2. Using Table Dialogue Box 

Following are the steps of creating a table using Table Dialogue Box in MS 

Word: 

Step 1: Go to the Insert tab and click on the Table button. 

 

 

Step 2: Under the grid, you will see an Insert Table button. Click on it. 
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Step 3: In the Insert Table Dialogue box, mention the number of rows and 

number of columns as per the requirement and click on OK button. 

 

 

Modify a Table 

We can also edit/modify a table to make it more creative. Multiple operations 

can be performed on a table like changing the layout, splitting of cells, 

merging the cells, applying borders, etc. Here, we will see some of the 

operations performed on a table in MS Word. 

1. Changing Layout of a Table 

Changing the layout of a table can be done with the help of the following 

steps:  

Step 1: Select the table for which the layout is to be changed. Go to the design 

tab. 
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Step 2: Click on the dropdown menu to get various different types of layouts 

for your table. 

 

 

Step 3: Select any layout as per the need. 

 

 

2. Splitting the Cell 

Splitting of a cell can be done with the help of the following steps: 

Step 1: Select the cell that you want to split into multiple cells. Then go to 

the Layout tab and click on the Split Cells button. 
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Step 2: In the dialogue box, mention the new dimensions as per the 

requirement.  

 

 

Step 3: Click on the Ok button. 
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3. Merging the Cells 

Merging of various cells can be done by the following steps: 

Step 1: Select all the cells that are to be merged into a single cell. Then go 

over the layout tab, and you will see a Merge Cell button. 

 

 

Step 2: Now click on the Merge Cell button and the selected cells will be 

merged. 

 

 

4. Applying Borders and Styles on a Table 

Borders and styles can also be applied to a table in a similar way as the layout 

of a table is changed. Go through the following steps to do the same: 
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Step 1: Select the entire table and go over the design tab. 

 

Step 2: Select the style that you want to apply to your table. 

 

5. Converting Text to a Table 

MS Word allows the conversion of existing text into a table with the help of 

the following steps: 

Step 1: Select the text that is to be converted into the table. Now go to 

the Insert Tab and you will see a Table button. 
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Step 2: Click on the Insert Table button and in the drop-down menu, click 

on the Convert Text to Table button. 

 

Step 3: In the dialogue box, mention the dimensions of the required table and 

other data that is required. 

Step 4: Click on the OK button and the selected text will be converted to a 

Table. 

6. Inserting Images in a Table 

MS Word allows adding images inside the table cells. To insert an image in a 

table, go through the following steps: 
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Step 1: Select the cell in which you want to add the Image. Go to the Insert 

tab and select the Pictures button. 

Step 2: You can either choose a picture from your device or select one online. 

Step 3: Choose a picture from the browser window and click on the Insert 

button. 

Step 4: Selected Image will be added in the cell selected. 
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7. Performing Calculations in a Table 

Mathematical calculations can also be performed on the values present in the 

table. Microsoft provides various formulas to perform these operations. By 

default, the sum of the values lying in the rows to the left or column lying 

above are calculated by Word. Following are the steps to do the same: 

Step 1: Select the cell in which the result of the mathematical operations is 

required.  

 

Step 2: Now go to the Layout tab and select the formula button.  

 

Step 3: In the dialogue box, define the formula for the mathematical 

operation, the default formula is the sum of the values to the left or above. 
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Step 4: After defining the formula, click on the OK button to apply the formula 

on the cells given in the formula. 

 

 

2.6. Micro Soft Power point presentation  

Information can be displayed using an electronic presentation 

application. This information is usually presented as a slide show — the data 

is displayed on a slide that may be viewed on a computer monitor or projected 

onto a screen using an LCD projector. A presentation might consist of multiple 

slides that are exhibited one after the other. The presentation tool in MS Office 

is MS PowerPoint. Microsoft PowerPoint is a popular presentation application, 

although there are alternatives such as Corel Presentations OpenOffice.org, 

Impress, etc.  

Three major components of a presentation program are:  

(i) An editor that allows text to be input and formatted  

(ii) Inserting visual pictures, audio, and video  

iii) Slide-show system to display the final content. 

I. Open MS PowerPoint: 

In Windows 8/above 

Step 1: Press Windows + c to open the search bar 
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Step 2: Type PowerPoint & click on the MS Office version you are having in 

your system. MS Office window will pop up. 

In Windows 7 or below: 

Step 1: Go to the program section in the windows start menu. 

Step 2: Go to MS Office & click on it. A drop-down list is seen 

Step 3: Click on MS PowerPoint & MS PowerPoint window will pop up. 

II. Creating a Presentation 

Once your MS PowerPoint Window pops up, you can create & save the file 

by: 

Step 1: Click on the Microsoft button on the top left. 
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Step 2: Click on new, a new Presentation window will pop up. 

 

Step 3: Click on Create & a new presentation will be created. (Ctrl +n) 

III. Saving a Presentation 

Once you have created a presentation, it can be easily saved with the help 

of following steps: 

Step 1: Click on the Microsoft icon 

Step 2: Click on the Save button 
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Step 3: A new Window for Save As will pop up.  

 

Step 4: Select the drive (by clicking on it: Example: Local Drive (D)) in which 

you want to save the presentation. Then your drive will open up, select the 

folder in which you want to save the presentation (Example: img folder here) 

& then give the required name to your presentation (Example: My 

presentation here). Your presentation is created & saved with the provided 

name. (Ctrl + s). 

 

2.6.1. Basic Elements of a PowerPoint Window/Slide 

You can see various bars in the presentation window. They are: 

(i) Title Bar:  

This shows the name/title given by you to the current presentation. If 

user do not save the presentation by any name, default name given by MS 

PowerPoint appears in this bar. 

(ii) Menu Bar:  

Contains menu items like insert, views, design, animations, etc.,  

(iii) Office Button: MS Office button on the left-most top. 

(iv)  Formatting Toolbar: Have tools like Bold, Italic, Underline, Font shape 

& size etc. to format your data. 

(v) Zoom Slider: To zoom in or zoom out your presentation. 

(vi) Slide Sorter Pane: This allows us to choose which slides will be shown 

in which sequence during the slide show. 
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 (vii) Notes Pane: This allows us to type notes that we may require later 

when preparing for the presentation, but they will not be displayed during 

the slide show. 

(viii) View Buttons: Provides different views of your presentation like: 

normal, slide show & slide sorter. 

(ix) Slide Pane: This is where we type, format, and otherwise design the 

slide. 

 

2.7. Concept of Slide Shows 

After preparing the presentation, it’s time for the slide show. Steps for slide 

show are: 

Step 1. Click on the view Option on the top Menu Toolbar 

Step 2. Click on the slide show option. 

Step 3. The slide show will start (Press Esc key (escape) to come out of slide 

show) (F5). 

2.8. Animating Objects in MS PowerPoint 

Animations in MS PowerPoint are the most interactive way to present 

the data to someone. Nowadays, animations keep people engaged with the 

concept which they are explaining using the help of PowerPoint. PowerPoint 

animations play a vital role to understand the most complicated topics very 
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easily. PowerPoint is commonly used by people in business and also the 

students to create the presentation. 

Features of MS PowerPoint 

There are multiple features available in MS PowerPoint, among all, we will 

discuss a few of them below;  

1. Slide Layout: There are multiple options available according to the 

requirement, based on which Presentations can be prepared. You can see 

the “Add Slide” option under the home tab itself. 

2. Insert-audio, video, clipart 

We can attach audio, videos, images, etc. inside the PowerPoint 

presentation to make the presentation more interesting. You can see all of 

them under the Insert tab. 

 

3. Slide-Design: MS PowerPoint has various themes using different types of 

textures and backgrounds as in-built. We can also create our own type of 

slide design and use it. You can see this option under the Design tab. 



64 
 

 

4. Animations 

PowerPoint animations are used to create games or movies. But 

majorly it is used for the purpose of education and business sectors. You 

can see this option under the Animations tab. Now we will learn more about 

animations in MS PowerPoint. 

 

2.9. Animations in PowerPoint 

Animations are one of the most important features of MS PowerPoint 

from which we can make creative templates out of it. Now we see the various 

options present under the animations tab and discuss them one by one: 

 Preview 

 Type of animation 

 Effect options 

 Add Animation 

 Animation Pane 
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 Trigger (available for new version) 

 

1. Preview 

Animation effects that you have applied will show when you play the slide 

show. You can preview the animations quickly for the current slide without 

clicking the option of the slideshow. 

Steps to preview: 

 Navigate to the slide you want to preview. 

 From the Animations tab, click the Preview command. The animations 

for the current slide will play. 

2. Type of Animation 

There are so many in-built animation effects provided by MS 

PowerPoint, and they are categorized into four types: 

Entrance: It has animations telling that how an object should enter. For 

example, with the fly animation, the object will “fly” onto the slide from any 

of the 4 directions. 
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Emphasis: This type of animation usually occurs by the mouse clicks i.e 

when the object is already on the slide. For example, we can make the object 

wave after the entrance animation has finished. 

Exit: These have a set of animations to control the exit animations. For 

example, in the Fade animation, the object will fade away. 

Motion Paths: They are similar to emphasis animation effects, but these 

animations are a little advanced as the object will move in a specified path. 

These paths can be edited also. 

Steps to apply the animation: 

Step 1: Select the object you want to animate. 

Step 2: Go to the animation tab and click on the dropdown to view all types 

of animations. 

Step 3: A drop-down menu of animation effects will appear. Select the 

desired effect. 

Step 4: The effect will apply to the object. In the Slide pane, a star symbol 

appears next to the slide, by which we can confirm that animation is applied. 
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3. Effect Options 

Some effects will have options you can change. For example, in the effect of 

the random bars, we can control that we need vertical or horizontal bars. We 

can use these options by accessing the Effect Options command in the 

Animation group. It totally depends on the animation which is selected. 

4. Add Animation 

If you want to add new animation then we can reselect in the animation 

group but to add new animation without changing the existing one we use 

this option. And sometimes to make the content interactive we need to add 

2 or more effects. To apply these changes click on Add Animation command, 

this option will allow adding new animations without changing the old ones. 

 

Steps to apply multiple animations to a single object: 

Step 1: Select an object. 

Step 2: Click the Animations tab. 
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Step 3: In the Advanced Animation group, we need to click the Add 

Animation command to view the available animations. 

Step 4: Select the desired animation effect. 

Step 5: If the object has multiple effects then for every effect it will show 

numbers according to the priority i.e numbers indicate the order in which 

the effects will occur. 

5. Animation Pane 

The Animation Pane option has the power to manage the timing of particular 

animations. You can easily modify the effects related to the animations like 

reordering the animations according to the preference and time interval. 

Steps for Operating Animation pane: 

Step 1: Open the Animations tab, on the right side click on the animation 

pane option. 

Step 2: A separate dialogue box gets opened on the right side of the window. 

It shows all the effects for the current slide in which they will appear. 

Step 3: We can also set the start time, delay time, and also we can set when 

to move to the next slide, for this, we have 3 options: 

 Start on Click 

 Start with Previous 

 Start after Previous 

Step 4: We can reorder animations with the help of two options which 

are a) Move Earlier b) Move Later 
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Steps to open the Effect Options dialogue box: 

Step 1: From the Animation Pane, select an effect and right-click on it. 

Step 2: Click the drop-down arrow, then select Effect Options. 

Step 3: The Effect Options dialogue box will appear. You can add extra 

enhancements to that particular effect: 

Sound: Adds a sound effect to the animation 

After animation: Changes the color or hides the object after the animation 

is over 

Animate text: This allows you to animate text all at once, one word at a 

time, or one letter at a time. 

Step 4: In the timing tab, we can add the delay before it starts and change 

the duration of the effect, and control whether the effect repeats or not. 
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6. Trigger 

A trigger is an object that you click to cause the animation to occur on a 

slide. Animation can be anything like motion, exist emphasis, or entrance 

motion path. You can click on any one object to trigger the animation of 

another object, but it is also possible to make the trigger object and the 

animated object the same. Generally, the animations happen in a pre-set 

order. 

Steps to apply trigger: 

Step 1: Firstly select the object to which you want to add a trigger. 

Step 2: Now click on the trigger option in the animations tab and select on 

click option. 

Step 3: Now you can see a list of animations applied to that object. 

Step 4: We can select what should happen if we click on that object i.e which 

animation should take place 
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2.10. MS Excel: Worksheet and Work Book 

A collection of worksheets is referred to as a workbook (spreadsheets). 

Workbooks are your Excel files. You’ll need to create a new workbook every 

time you start a new project in Excel. There are various ways to begin working 

with an Excel workbook. You can either start from scratch or use a pre-

designed template to create a new workbook or access an existing one. 

I. Creating a new Workbook 

Follow these steps to create a new Blank workbook, giving a name to it & 

saving it: 

Step 1: Click on the Microsoft Office button on the top-left corner. 

Step 2: Then click on New. 

Step 3: A dialog box for New Workbook will pop up. Click on blank Document 

& then on Create tab. 

 

 

 

 

 

 

 

 

A new blank workbook is created & it appears on your screen. 
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II. Inserting Text in Excel 

In Excel, you can see multiple rows & columns, each rectangular box in a row 

or any column is called a Cell. A cell address on a worksheet can be 

determined by combining a column letter and a row number. Using these 

addresses, we can refer to any cell (in Excel formulas) in the worksheet. As 

you click on any of the cells, you can see its address in the name box (Left 

most side below the home tab). 

Step 1: Select a cell in which you want to insert text. 

Step 2: Insert your data by typing something from the keyboard (In that 

selected cell) 

Whatever text you enter, the same text appears in the formula bar too (for 

that cell). 

III. Edit/Delete Cell Contents 

Step 1. Select the cell to change or delete the text. 

Step 2. To erase text and make a correction, press the Backspace key on your 

keyboard. 

Or, to erase the whole contents of a cell, press the Delete key. 
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Or, the formula bar also allows you to alter and erase text. Simply select the 

cell and then position your cursor in the formula bar. 

Navigation in Excel 

Step 1. Go to the right of the selected cell, press the Tab key. 

Step 2. To move to the left of the selected cell, hold down Shift and then Tab. 

Step 3. To traverse the worksheet, use the Page Up and Page Down keys (with 

Shift in Laptops). 

Step 4. Use the arrow keys to navigate. 

 

IV. Saving the Workbook 

Step 1. Click the Microsoft Office button on the left. 

Step 2. Save or Save as are the options, choose one. 

Save As – lets you give the spreadsheet a name and save it in a specific 

location. If you want to save the file for the first time, or if you want to save it 

under a new name, select Save As. If the file has already been named, just 

choose Save/press Ctrl + S to save your work. 
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V. Using Formulas in Excel 

You can use predefined Excel formulas by just typing: “=Formula Name 

(Arguments)”. When you type the first few characters of any formula, excel 

provides a drop-down list of formulas matching that sequence of characters. 

Example: To get an average of numbers present in the column B from row 2 

to row 6, you can use the formula: = AVERAGE (B2:B6) 

Here B2:B6 defines the range of the numbers on which you want to do 

average. 

You can see the formula in the formula tab near the name box. 

Here in the cell: B8 we wrote: = AVERAGE (B2:B6), so we get average as = 

(1+2+3+4+5)/5 = 15/5 = 3. 

So, in this way you can easily create a workbook, work on it, and navigate 

through it & save it. 
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Check Your Progress: 

Q.No                                        Short Questions                                           LOCF Mapping     

1. 

 

2. 

3. 

 

4. 

5. 

Summarize the concept of worksheet and workbook in MS 

Excel. 

Choose the importance of formatting in MS word documents. 

List out the steps involved in creating and formatting text in MS 

Word. 

Describe the procedure for creating tables in micro soft word. 

Explain the importance of slide design and layout in power 

point presentations. 

K1 

 

K6 

K1 

 

K2 

K5 

CO1 

 

CO2 

CO3 

 

CO4 

CO2 

PO1 

 

PO5 

PO1 

 

PO1 

PO4 

Q.No                                        Essay Type Questions                                LOCF Mapping 

1. 

 

2. 

 

3. 

 

4. 

 

5. 

Analyze the advantages of Excel for data analysis and 

presentation. 

Evaluate the role of MS Office applications in improving 

productivity in organizations. 

Discuss the relationship between Word, Excel and Power point 

in integrated office applications. 

Explain the importance of slide animations and transitions in 

power point presentations. 

Examine the role of MS Office tools in business communication 

and documentation. 

K1 

 

K3 

 

K5 

 

K5 

 

K2 

CO4 

 

CO2 

 

CO5 

 

CO1 

 

CO5 

PO1 

 

PO3 

 

PO4 

 

PO4 

 

PO2 
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UNIT – III 

DATA PROCESSING 

3.1. Introduction 

Data Analysis with Excel is a detailed lesson that gives readers a clear 

understanding of the newest and most sophisticated functions offered by 

Microsoft Excel. It describes in detail how to use MS-capabilities Excel to carry 

out various data analysis tasks. The guide includes a good amount of 

screenshots that step-by-step demonstrate how to use various features. One 

of the most used programs for data analysis is Microsoft Excel. You can simply 

import, browse, clean, analyse, and display your data using this all-in-one 

data management tool. 

3.2. Data Analysis 

Data analysis is the process of inspecting, cleaning, transforming, and 

modelling data to discover useful information, draw conclusions, and support 

decision-making. It involves a variety of techniques and methods for 

extracting insights from raw data, with the ultimate goal of gaining a deeper 

understanding of patterns, trends, relationships, and characteristics within 

the dataset. 

Data analysis with Excel is a common and accessible way for 

individuals and businesses to analyze and visualize data. Microsoft Excel 

provides a range of tools and functions for performing basic to advanced data 

analysis tasks. The software enables users to seamlessly import and organize 

data from various sources, facilitating a structured foundation for analysis. 

Data cleaning becomes an intuitive process with Excel’s capabilities, allowing 

users to identify and rectify issues like missing values and duplicates. 

PivotTables, a hallmark feature, empower users to swiftly summarize and 

explore large datasets, providing dynamic insights through customizable 

cross-tabulations. 

3.3. Types of data 

Microsoft Excel software, there are four different Excel data types. 

These four different data types represent four different values. Each data type 

enables users to perform a different function, which is why it's extremely 

valuable to understand each type and understand how to use these different 
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data types and their functions. The different data types may also change their 

form in spreadsheets once exported onto them. Excel data types is important 

because they form the foundation of the advanced functions taught 

in Microsoft Excel training courses. The four major data types in Excel are: 

1. Number  

 This data type is used to represent numerical values, such as the 

number of employees, phone numbers of group members, and value of money 

spent. The number data type also allows you to input percentages, decimals, 

dates, times, and integers using a workbook in Excel. In Excel, you can input 

number data from minimal to substantial values, but you should remember 

that Excel supports a maximum of fifteen digits in a cell. After the fifteenth 

digit, Excel removes them and replaces them with zeroes.  

 2. Text  

  This is the most basic data type in Microsoft Excel. Text data allows you 

to input characters such as alphabetical, numerical, and special symbols. 

However, unlike number data, numerical symbols inputted as text data do 

not support calculations. Excel allows you to manually switch between text 

and number data to ensure it operates as you want. However, by default, 

Excel may categorize figures it doesn’t recognize as text data. To convert 

numbers stored as text data to number data, highlight the cells or columns. 

On the ‘Data’ tab, click ‘Text to Columns,’ then click ‘Finish.’  

3. Logical  

  Logical data types are some of the most powerful tools you can use on 

the software. Excel displays logical values as either TRUE (or 1, in Boolean 

value) or FALSE (or 0 in Boolean value). Unlike the previous data types, you 

cannot manually type any of the basic Logical data into an Excel worksheet.  

 Here are the basic Logical Excel functions: 

 AND - used when you want to check if your data meets multiple 

conditions. You can use it to check if the value in one cell is bigger than 

those in another. 

 OR - used to compare values or statements in your data that meet a 

condition. If none of the data matches your conditions, Excel produces 

a false value.  
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 XOR - short for Exclusive OR, XOR is used when only one argument in 

your data can be marked as True or False. 

 NOT - used when you want to filter arguments that don’t match your 

conditions. Arguments that meet your conditions in the data are 

marked as True, while those that don’t are marked False. These 

functions will also help you extract duplicates in Excel. 

4. Error 

When Excel recognizes a mistake or missing information while 

processing your data, it outputs ‘Error’ data. For example, if the beginning or 

end quote is missing in a formula, Excel will display #NAME? and #NUM! for 

an invalid formula or function. 

5. Linked Excel Data Types 

Microsoft Excel also allows you to input data sourced online into your 

worksheet. These data types can be inputted as ‘Stocks Data’ and ‘Geography 

Data.’ Both are considered linked data types in Excel. These data types allow 

you to insert a live value from the stock market or information about 

geographical locations. The data is sourced from the internet.  

You can only use the ‘Stocks’ and ‘Geography’ data types with a Microsoft 365 

account or with a free Microsoft Account. 

 

3.4. Data Entry 

In the dynamic world of Microsoft Excel, there’s an often-overlooked 

gem that can revolutionize how you input, manage, and validate data within 

your spreadsheets – the Excel Data Entry form. Whether you’re a novice user, 

you can unlock the power of data entry forms and streamline your 

spreadsheet operations. 

Excel Data Entry Form 

Data Entry Form is a form that helps to enter the data with the help of 

a form in which the data can be added, searched, and previous data can be 

deleted. Data entry in Excel without forms can be very time-consuming. There 

are two major issues faced while conducting data entry without forms in 

Excel: 
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1. Time-consuming: Without forms, data needs to be entered in one cell at 

a time, then go to the next cell and enter the data for that cell, and so on. 

Sometimes, due to confusion, the user might need to scroll up and see which 

column is it and what data needs to be entered and then come back to the 

current position. Similarly, in the case when the user needs to scroll right and 

then come back to the beginning. 

2. Error-prone: If there is a huge dataset that needs 100 entries to be entered 

in the form. In that case, there may be a possibility that the user 

unintentionally enters the wrong data in the cell. 

Data entry using forms in Excel helps to overcome all these limitations and 

makes the task of entering data less time-consuming and less error-prone.  In 

this article, let’s have a look into how to Data Entry Forms in Excel.  

How to Add the Form Tool to Excel 

To add the form tool, we need to make it visible as it’s hidden by default. For 

this, we need to add it to the ribbon. 

Step 1: Right-click on the Quick Access Toolbar 

To add the Data Entry Form option on the Quick Access Toolbar. First, right-

click on any of the existing icons in the Quick Access Toolbar. Then, click on 

Customize Quick Access Toolbar…” 

 

Step 2: Select All Commands 

In the “Excel Options” box select “All Commands” in Choose commands from.  
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Step 3: Select Form and Click Add 

Select “Form” from the list of commands then click on “Add>>”, and then click 

Ok. 

 

Step 4: Preview Form Icon 

Now, the Form icon is added on Quick Access Toolbar. 

 

How to Make Data Entry Form in Excel 

If you’ve ever struggled with typing data directly into Excel cells, Excel offers 

a nifty solution called a “Data Entry Form”, designed to make entering, 

managing, and validating data a breeze. You just need to enter your data in a 

table and and click on form button. Follow the below steps to create a Data 

Entry form: 

Step 1: Prepare your Data 
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Begin setting up your data in an Excle table. If you’re starting from a scratch, 

type your column headings in the first row. If you’re working with an existing 

dataset, then you can ignore this step. 

Step 2: Create or Convert to a Table 

You can create your table and enter the data in a new spreadsheet or if 

working on an already existing spreadsheet then select any cell within your 

dataset and press “Ctrl +T” together. This shortcut will transform your data 

into functional table. 

Step 3: Create the Form 

Now place your cursor anywhere wihtin the table, and now click on 

the “Form” button. 
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How to Add a New Record in Data Form 

This section will discuss the steps to use the data entry form in Excel. 

Step 1: Select the Cell and Click on Form Icon 

Select any cell from any column and then click the “Form” icon. 

 

Step 2: Click on New in the Sheet1 Box 

After that to add a new row click on “New” in the Sheet1 box. 

 

Step 3: Enter Information and Then Click Close 

Then, Add Name, Age, and Class, and then click Close. 

Step 4: Preview the Row 

Now, our row is added. 
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3.5. Data Storage and Retrieval 

Data storage is the process of saving data in a persistent and accessible 

way. Data can be stored in different formats, such as files, databases, data 

warehouses, or data lakes. Data storage involves choosing the right storage 

medium, such as hard disks, solid-state drives, tapes, or cloud services, and 

the right storage architecture, such as hierarchical, network, relational, or 

object-oriented. Data storage also requires ensuring data quality, security, 

and backup. 

Data retrieval 

Data retrieval is the process of accessing and extracting data from a storage 

system. Data retrieval involves using queries, commands, or applications to 

locate and retrieve the data that meets certain criteria or needs. Data retrieval 

also requires ensuring data integrity, consistency, and availability. Data 

retrieval can be performed by humans or machines, and it can be done for 

various purposes, such as analysis, reporting, or decision making. 

The relationship between data storage and retrieval 

Data storage and retrieval are interdependent and complementary 

processes. Data storage provides the foundation for data retrieval, as it 

determines how the data is organized, indexed, and accessed. Data retrieval 

provides the value for data storage, as it enables the data to be used for 

various functions and insights. Data storage and retrieval also influence each 

other in terms of performance and efficiency, as they depend on factors such 

as data volume, data velocity, data variety, and data veracity. 
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Check Your Progress: 

Q.No                                        Short Questions                                           LOCF Mapping     

1. 

 

2. 

 

 

3. 

 

4. 

 

5. 

Explain the basic features and interface of MS Excel, including 

the workbook, worksheet, and cell structure. 

Describe the arithmetic operators used in Excel with examples 

of formulas for addition, subtraction, multiplication and 

division. 

Distinguish between arithmetic operators and comparison 

operators in excel with suitable examples. 

Discuss the logical operations in Excel and explain how logical 

functions such as IF, AND, OR are used in spreadsheets. 

Illustrate the structure of excel formulas and explain how 

operators are used in calculations. 

K2 

 

K2 

 

 

K3 

 

K3 

 

K3 

CO1 

 

CO2 

 

 

CO2 

 

CO2 

 

CO2 

PO21 

 

PO1 

 

 

PO2 

 

PO3 

 

PO1 

Q.No                                        Essay Type Questions                                LOCF Mapping 

1. 

 

2. 

 

 

3. 

 

4. 

 

5. 

Elaborately discuss the calculation operators in Excel, 

including arithmetic, comparison and logical operators. 

Discuss the various text and table formatting techniques 

available in excel and explain how they improve data 

presentation. 

Evaluate the importance of graphical representation of data in 

Excel using charts such as bar charts, line charts and pie charts. 

Explain the process of creating and formulation graphs in excel 

and discuss how graphical tools help in data interpretation. 

Develop a formatted excel table for sales data and demonstrate 

how operators and formatting tools enhance analysis and 

readability. 

K1 

 

K3 

 

 

K5 

 

K3 

 

K6 

CO4 

 

CO3 

 

 

CO4 

 

CO4 

 

CO5 

PO1 

 

PO3 

 

 

PO4 

 

PO2 

 

PO3 
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UNIT – IV 

INTRODUCTION TO MS EXCEL 

4.1. Introduction 

MS-EXCEL is a part of Microsoft Office suite software. It is an electronic 

spreadsheet with numerous rows and columns, used for organizing data, 

graphically representing data(s), and performing different calculations.  It 

consists of 1048576 rows and 16384 columns, a row and column together 

make a cell. Each cell has an address defined by column name and row 

number example A1, D2, etc. This is also known as a cell reference. Excel has 

a rich variety of operators to perform calculative actions on a given set of data. 

Excel operators specify the calculation to be performed on a given set of 

values. Obviously not restricted to numeric values only, we can use operators 

over different data types other than numeric (for example, Text/Character 

data type). In this article, we will see what the different types of Excel 

operators are and how those can be used to make your day to day life easy. 

4.2. Types of Operators in Excel 

There are 4 crude types of operators in Excel, mentioned below: 

 Arithmetic Operators 

 Logical/Comparison Operators 

 Text Concatenation Operator 

 Reference Operators 

Each type consists of a set of specifically meant operators for that particular 

group (except the Text Concatenation Operator, which has only one operator). 

We’ll see each of them according to the order mentioned above. Let’s 

understand How Different Types of Operators work in Excel with some 

examples. 

4.2.1. Arithmetic Operators in Excel 

In Excel, there are six major arithmetic operators that you can use to perform 

calculations. 

1. Addition (+) 

2. Subtraction (-) 

3. Multiplication (*) 

4. Division (/) 
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5. Percent (%) 

6. Exponentiation (^) 

1. Addition (+): 

The addition operator in Excel calculates the sum of two or more values. The 

Syntax of addition operation is: =number1 + number2 Example: =A1 + B1 

To use different operators, follow these steps: 

Step 1: Open a blank Workbook in Excel. 

Step 2: Add data in cells to perform calculations. And place the cursor in the 

cell where you want to put the result. 

 

Step 3: Go to the Insert Function tab as shown type =number1 + number2, 

Press Enter. For example, we used the addition operation for two numbers, 

200 and 250, and their sum is 450. 
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Step 4: Your sum of two values will be added to its designated cell. 

 

Step 5: Use the cell locations of numbers on which you want to perform 

addition. When you add the cell location of a number, it will be highlighted, 

as shown in the picture below. For example, instead of adding values 

themselves, add their cell locations to add them. I used A2 for "200" and B2 

for "250". Because the number "200" lies in the second row of column A and 

"250" lies in the second row of column B. 



88 
 

 

2. Subtraction (-): 

The subtraction operator is used to subtract or subtract one value from 

another. Go to the insert function tab and type =values or cell locations you 

want to subtract in the formula bar. 

 

For example, if you want to subtract B2 from A2. Type =B2-A2 or =250-200. 

Alternatively, Type cell location in formula bar. Type =B2-A2 in formula bar 

and press enter. 
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3. Multiplication (*):  

Asterisk operator calculates multiplication between the two numbers. Go to 

the insert function tab. You can insert the cell's location or values to perform 

multiplication. 
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4. Division (/):  

The forward slash performs Division between two or more numbers. Use the 

Syntax: Dividend/divisor. For example, divide B2 with A2. 

 

5. Percentage (%):  

Percentage operator converts numeric values into percentage. If you want to 

add a percentage sign with a value in a cell, enter the values in a cell and then 

the percentage operator from the keyboard. 

 

6. Exponent (^):  

Excel allows you to raise the number to any power. You can directly enter an 

exponent operator from the keyboard and use a number to raise the power. 

You can calculate squares, cubes, and up to any power you want. 
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4.3. Comparison operators in excel: 

Comparison operators are very helpful in Excel to force a Boolean result from 

a formula. Once we test two values against each other, we can return a desired 

result based on whether the outcome is TRUE or FALSE. 

Here is a list of the most common comparison operators: 

 Equal Sign (=): Checks if two values are equal to each other. Returns 

TRUE if values are EQUAL 

 Not equal (<>): Checks if two values are not equal to each other. Returns 

TRUE if values are NOT equal. 

 Less Than (<): Checks if first value is less than second value. Returns 

TRUE if first value is less than second value. 

 Greater Than (>): Checks if first value is greater than second value. 

Returns TRUE if first value is greater than second value. 

Logical operators in excel: 

 Equal to (=) compare one value to another value. 

 Not Equal (<>): Test whether the value is not equal to a value or not. 

 Greater Than (>): Test whether the value is greater than a value or not. 

 Less Than (<): Test whether the value is less than a value or not. 

 Greater than or equal to (>=): Test whether the value is greater than or 

equal to a value. 

 Less than or equal to (<=): Test whether the value is less than equal to 

a value. 
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4.4. Excel Tool Bars: 

Excel toolbar (also called Quick Access Toolbar) is presented to access various 

commands to perform the operations. In addition, it is presented with an 

option to add or delete commands to it to access them quickly. 

 Quick Access Toolbar is universal, and access is possible on any tab 

like “Home,” “Insert,” “Review,” “References,” etc. It is independent of 

the tab that we are working on simultaneously. 

 It contains the various options used frequently to enhance the speed of 

working in Excel sheets. 

 Along with the Quick Access Toolbar, another toolbar such as the 

“Formula Bar,” “Headings,” and Gridlines in excel under the “Show” or 

“Hide” group of the “View” tab simply selecting and deselecting the 

checkmark shows or hides this toolbar. 

 “Format” toolbar, “Drawing” toolbar, “Chart” toolbar, and “Standard” 

toolbar presented in the earlier version of Excel 2003 are modified into 

the “Home” tab and “Insert” tab in the later versions of Excel 2007 and 

more. 

 The “Customize Quick Access Toolbar” option is available to access the 

full toolbars list. 

 

4.4.1. Use the toolbar in Excel 

 The toolbar in Excel is used for various purposes. However, few major 

activities are performed on the Quick Access Toolbar on different 

versions of Excel. 
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 In the 2007 version, only three activities shift the toolbar’s location, 

including adding extra features or frequently used commands. In 

addition, deleting an element from the toolbar is possible whenever we 

do not want to. 

 In higher versions than in 2007, the Quick Access Toolbar is used in 

many ways, along with adding and removing commands. These include 

adding commands not presented on the toolbar, modifying commands 

order, moving the toolbar below or above the ribbon, grouping two or 

more commands, exporting and importing the toolbar, customizing 

utilizing the “Options” command, and resetting the default settings. 

 Frequent commands like “Save,” “Open,” “Redo,” “New,” “Undo,” 

“Email,” “Quick Print,” and print preview in excel are easily added to 

the toolbar. 

 We can select the commands not listed in the toolbar from the three 

categories, including “Popular Commands,” “All Commands,” and 

“Commands Not Listed” on the ribbon. 

4.4.2. Examples to Understand Quick Access Excel Toolbar 

Below are examples of the Excel toolbar. 

1. Adding Features to the Toolbar 

Adding features or commands to the Quick Access Toolbar is essential. It is 

done in three ways: 

 Adding commands located on the ribbon. 

 Adding features through the “More Commands” option. 

 Adding the elements presented on the different tabs directly to the 

toolbar. 

Method 1 

We can add “New,” “Open,” “Save,” “Email,” “Quick Print,” and redo in 

excel features to the toolbar. For that, select the “Customize Quick Access 

Toolbar” button and click on the command you want to add to the toolbar. 
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Method 2 

In this, a user must select the “Customize Quick Access Toolbar” in Excel and 

select the “More Commands” option to add the commands. 

As shown in the below figure of the customize window, the user must select 

the commands and click on the “Add” option to add the feature to the toolbar. 

Added features are displayed on the excel ribbon for accessing easily. 
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Method 3 

The user has to right-click on the feature presented on the ribbon and choose 

“Add to Quick Access Toolbar.” 

 

4.5. FORMATTING OF TEXT 

The appearance of your documents helps to convey their message. You can 

easily format words and paragraphs so that key points stand out and the 

structure of your document is clear. You can also change the look of major 

elements within a document by applying predefined sets of formatting called 

styles, and you can change the look of selected text by applying predefined 

combinations called text effects. In addition, you can change the fonts, colors, 

and effects throughout a document with one click by applying a theme. 

1. Applying styles to text 

Styles can include character formatting (such as font, size, and color), 

Paragraph formatting (such as line spacing and outline level), or a 

combination of both. Styles are stored in the template that is attached to a 

document. By default, blank new documents are based on the Normal 

template. The Normal template includes a standard selection of styles that fit 

the basic needs of most documents. These styles include nine heading levels, 

various text styles including those for multiple levels of bulleted and 

numbered lists, index and table of contents entry styles, and many specialized 

styles such as those for hyperlinks, quotations, placeholders, captions, and 

other elements. Style sets are available from the Document Formatting menu 

on the Design tab. 

2. Changing a document’s theme 
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 Every document you create is based on a template, and the look of the 

template is controlled by a theme. The theme is a combination of coordinated 

colors, fonts, and effects that visually convey a certain tone. To change the 

look of a document, you can apply a different theme by clicking the Themes 

button in the Document Formatting group on the Design tab, and then 

making a selection in the Themes gallery. If you like the background elements 

of one theme but not the colors or fonts, you can mix and match theme 

elements. First apply the theme that most closely resembles the look you 

want, and then select colors and fonts from the Theme Colors and Theme 

Fonts galleries in the Document Formatting group. 

3. Changing a document characters 

When you enter text in a document, it is displayed in a specific font. By 

default, the font used for text in a new blank document is 11- point Calibri, 

but you can change the font of any element at any time. The available fonts 

vary from one computer to another, depending on the programs installed. 

Common fonts include Arial, cambria, and Times New Roman. 

You can vary the look of a font by changing the following attributes: 

 Size almost every font comes in a range of sizes, which are measured in 

points from the top of letters.  

 Style Almost every font has a range of font styles. The most common 

are regular (or plain), italic, bold, and bold italic. 

 Effects Fonts can be enhanced by applying effects, such as underlining, 

small capital letters (small caps), or shadows. 

 Color A palette of coordinated colors is available, and you can also 

specify custom colors. 

 Character spacing:  You can alter the spacing between characters. 

4. Changing the look of Paragraphs: 

A paragraph is created by entering text and then pressing the Enter 

key. A paragraph can contain one word, one sentence, or multiple sentences. 

You can change the look of a para- graph by changing its indentation, 

alignment, and line spacing, as well as the space before and after it. You can 

also put borders around it and shade its background. Collectively, the settings 

you use to vary the look of a paragraph are called paragraph formatting. In 
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Word, you don’t define the width of paragraphs and the length of pages by 

defining the area occupied by the text; instead you define the size of the white 

space the left, right, top, and bottom margins around the text. You click the 

Margins button in the Page Setup group on the Page Layout tab to define 

these margins, either for the whole document or for sections of the document. 

Although the left and right margins are set for a whole document or section, 

you can vary the position of the paragraphs between the margins. The 

quickest way to indent a paragraph from the left is to click the Increase Indent 

button; clicking the Decrease Indent button has the opposite effect. 

5. Applying Borders and Shading 

 To enhance the appearance of the text in a paragraph, you can quickly 

add a border and shading to selected text. When you add a border, you can 

specify what sides you want to include or exclude. For example, you can add 

a border on just the top and the bottom and leave the sides open. Shading 

colours the background behind the selected text or paragraph. If you want to 

customize borders and shading by changing line style, color, and width 

preferences, you can make changes in the Borders and Shading dialog box. 

Apply Paragraph Shading and Borders 

 Select the paragraph text you want to format. 

 Click the Home tab. 

 Click the Borders and Shading button arrow, and then click 

Borders and Shading. 

 Click the Borders tab. 

 Click to select the type of setting you want for your border. 

 Click to select the type of Style. 

 Apply any other options you want. 

 Look in the preview box to see the new border. 

 Click the Shading tab. 

 Click to select the shading fill colour you want to apply to your 

table. 

 Apply any other options you want. 

 Look in the preview box to see the new shading color. 

 Click OK. 
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6. Creating and modifying lists 

Lists are paragraphs that start with a character and are formatted with a 

hanging indent so that the characters stand out on the left end of each list 

item. Fortunately, Word takes care of the formatting of lists for you. 

You simply indicate the type of list you want to create. When the order of 

items is not important for example, for a list of people or supplies a bulleted 

list is the best choice. And when the order is important for example, for the 

steps in a procedure you will probably want to create a numbered list. 

You can format an existing set of paragraphs as a list or create the list as you 

enter information into the document. 

To format a new list item as you enter content, start the paragraph as follows: 

▪ Bulleted list 

Bulleted list Enter * (an asterisk) at the beginning of a paragraph, and Figure 

60 Shading Dialog then press the Spacebar or the Tab key before entering the 

list item text. 

▪ Numbered list Enter 1. (The number 1 followed by a period) at the beginning 

of a paragraph, and then press the Spacebar or the Tab key before entering 

the list item text. 

When you start a list in this fashion, Word automatically formats it as a 

bulleted or numbered list. When you press Enter to start a new item, Word 

continues the formatting to the new paragraph. Typing items and pressing 

Enter adds subsequent bulleted or numbered items. To end the list, press 

Enter twice; or click the Bullets arrow or Numbering arrow in the Paragraph 

group on the Home tab, and then in the library, click none. 

Choose a multilevel list style from the gallery: 

 Click where you want to begin your list. 

 On the Home tab, in the Paragraph group, click the arrow next to 

Multilevel List. 

 Click a multilevel list style in the gallery of styles. 

 Type your list. Press the TAB key or SHIFT+TAB to change levels. 

7. Controlling what appears on each page 

When a document includes more content than will fit between its top and 

bottom margins, Word creates a new page by inserting a soft page break (a 
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page break that moves if the preceding content changes). If you want to break 

a page in a place other than where Word would normally break it, you can 

insert a manual page break in one of three ways: 

 Click Page Break in the Pages group on the Insert tab. 

 Click Breaks in the Page Setup group on the Page Layout tab, and then 

click Page. 

 Press Ctrl+Enter 

 If a paragraph breaks so that most of it appears on one page but its last 

line appears at the top of the next page, the line is called a widow. If a 

paragraph breaks so that its first line appears at the bottom of one page and 

the rest of the paragraph appears on the next page, the line is called an 

orphan. These single lines of text can make a document hard to read, so by 

default, Word specifies that a minimum of two lines should appear at the top 

and bottom of each page. 

4.6. Tables and Graphs 

Charts are used to represent the data into graphical elements, which makes 

it very too easy to interpret the data; it becomes very useful if our data is very 

large. Excel provides various charts to represent the excel data and makes it 

very easy to understand and analyze the data compare to the excel cells data 

analysis. There are various charts available in excel. Namely, they are, 

 Line Chart 

 Bar Chart 

 Column Chart 

 Area Chart 

 Pie Chart 

 Surface Chart 

In this example, we will be using random car sales data, including model 

name and the number of cars sold, as the dataset and represent it in the 

various graphs. The charts or graphs are the visual representation of data in 

both rows and columns. They are used to analyze the trends and patterns in 

the datasets. 
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For example, if we want to analyze the sales of different courses for a specific 

period we can easily do this with the help of charts and get the result of 

queries such as months having a maximum number of sales etc. 

4.6.1. Insert a Table 

Tables may be easily added to a text document. 

Place cursor in document where you want to insert the table. 

1. Click the Insert tab 

2. In the Tables group, select dropdown menu. 

3. Select Insert Table from the resulting menu. 

4. In the Table Size section, enter the number of columns and 

rows.                  

5. Optional: Select options in the AutoFit behavior 

6. Click OK 

To quickly insert a table, click the Table button in the Tables group and drag 

to select the number of rows and columns. Click in last selected cell of grid to 

insert Table. 
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4.6.2. Converting Text to Table 

Sometimes text in a document may be better illustrated as a table. To convert 

existing text to a table: 

 Highlight text to be converted to a Table. 

 Click the Insert tab >Table> Convert Text to Table> dialog box opens. 

 Complete fields for options: Table Size, Auto fit and Separation 

character 

 Click OK. 

4.6.3. Inserting a Picture, Clip Art, Shape, SmartArt, or Screenshot 

Pictures and graphics add punch to your document, but remember not to 

overdo them! They are there to enhance your information, not eclipse it! 

Place cursor in the document where you want to insert the item 

On the Insert tab, in the Illustrations group, do one of the following: 

To insert a Picture from a file: select Picture. Locate and select the file you 

want to insert from your computer and click the Insert 

To insert an Online Picture: select Online Pictures. In the task pane, enter 

a keyword in the Search box and click the magnifying glass icon. Select 

desired image and click 

To insert a Shape: click the Shapes dropdown menu. Select the Shape you 

want from the resulting menu. Click and drag in the document to create 

the Shape. 

To insert a SmartArt Graphic: select SmartArt. Select the desired SmartArt 

graphic from the menu. Click OK.  
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To insert a Screenshot: select Screenshot button.  To insert a screen that 

you have open on your computer, select the screen from the Available 

Windows. To create your own screenshot, select Screen Clipping.  Click and 

drag the area of your screen you want to insert. 

 

4.6.4. Inserting a Chart or Graph 

On the Insert tab, in the Illustrations group, click Chart.   

Select the type of chart desired and click OK.                                                                 

Edit the data in the Excel sheet that opens with the Chart. When you are 

finished editing the data, close the data sheet. 
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4.6.5. Changing data in an existing chart 

 Select the Chart in your document 

 In the Chart Tools contextual tab in the Ribbon, select Design tab>Edit 

Data 

 A data spreadsheet will open; make desired changes 
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Check Your Progress: 

Q.No                                        Short Questions                                           LOCF Mapping     

1. 

 

2. 

 

 

3. 

 

4. 

 

5. 

Explain the basic features and interface of MS Excel, including 

the workbook, worksheet, and cell structure. 

Describe the arithmetic operators used in Excel with examples 

of formulas for addition, subtraction, multiplication and 

division. 

Distinguish between arithmetic operators and comparison 

operators in excel with suitable examples. 

Discuss the logical operations in Excel and explain how logical 

functions such as IF, AND, OR are used in spreadsheets. 

Illustrate the structure of excel formulas and explain how 

operators are used in calculations. 

K2 

 

K2 

 

 

K3 

 

K3 

 

K3 

CO1 

 

CO2 

 

 

CO2 

 

CO2 

 

CO2 

PO21 

 

PO1 

 

 

PO2 

 

PO3 

 

PO1 

Q.No                                        Essay Type Questions                                LOCF Mapping 

1. 

 

2. 

 

 

3. 

 

4. 

 

5. 

Elaborately discuss the calculation operators in Excel, 

including arithmetic, comparison and logical operators. 

Discuss the various text and table formatting techniques 

available in excel and explain how they improve data 

presentation. 

Evaluate the importance of graphical representation of data in 

Excel using charts such as bar charts, line charts and pie charts. 

Explain the process of creating and formulation graphs in excel 

and discuss how graphical tools help in data interpretation. 

Develop a formatted excel table for sales data and demonstrate 

how operators and formatting tools enhance analysis and 

readability. 

K1 

 

K3 

 

 

K5 

 

K3 

 

K6 

CO4 

 

CO3 

 

 

CO4 

 

CO4 

 

CO5 

PO1 

 

PO3 

 

 

PO4 

 

PO2 

 

PO3 
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UNIT – V 

Application of MS Excel in Statistics and Economics 

5.1. Descriptive statistics 

Descriptive statistics is a subfield of statistics that deals with 

characterizing the features of known data. Descriptive statistics give 

summaries of either population or sample data. Aside from descriptive 

statistics, inferential statistics is another important discipline of statistics 

used to draw conclusions about population data. 

Descriptive statistics is divided into two categories: 

 Measures of Central Tendency 

 Measures of Dispersion 

Descriptive statistics is a branch of statistics focused on summarizing, 

organizing, and presenting data in a clear and understandable way. Its 

primary aim is to define and analyze the fundamental characteristics of a 

dataset without making sweeping generalizations or assumptions about the 

entire data set. The main purpose of descriptive statistics is to provide a 

straightforward and concise overview of the data, enabling researchers or 

analysts to gain insights and understand patterns, trends, and distributions 

within the dataset. Descriptive statistics typically involve measures of central 

tendency (such as mean, median, mode), dispersion (such as range, variance, 

standard deviation), and distribution shape (including skewness and 

kurtosis).  

5.2. Definition of Descriptive Statistics 

Descriptive statistics is a type of statistical analysis that uses 

quantitative methods to summarize the features of a population sample. It is 

useful to present easy and exact summaries of the sample and observations 

using metrics such as mean, median, variance, graphs and charts. 

5.3. Types of Descriptive Statistics 

There are three types of descriptive statistics: 

1. Measures of Central Tendency 

2. Measures of Dispersion 

3. Measures of Frequency Distribution 

 

https://www.geeksforgeeks.org/central-tendency/
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1. Measures of Central Tendency 

The central tendency is defined as a statistical measure that may be used 

to describe a complete distribution or dataset with a single value, known as a 

measure of central tendency. Any of the central tendency measures accurately 

describes the whole data distribution. In the following sections, we will look 

at the central tendency measures, their formulae, applications, and kinds in 

depth. 

 Mean 

 Median 

 Mode 

Mean 

Mean is the sum of all the components in a group or collection divided 

by the number of items in that group or collection. Mean of a data collection 

is typically represented as x̄ (pronounced “x bar”). The formula for calculating 

the mean for ungrouped data to express it as the measure is given as follows: 

For a series of observations: 

x ̄ = Σx / n 

 Where, 

 x ̄ = Mean Value of Provided Dataset 

 Σx = Sum of All Terms 

 n = Number of Terms 

Median 

Median of a data set is the value of the middle-most observation 

obtained after organizing the data in ascending order, which is one of the 

measures of central tendency. Median formula may be used to compute the 

median for many types of data, such as grouped and ungrouped data. 

Ungrouped Data Median (n is odd): [(n + 1)/2]th  term 

Ungrouped Data Median (n is even): [(n / 2)th term + ((n / 2) + 1)th term]/2 

Mode 

Mode is one of the measures of central tendency, defined as the value 

that appears the most frequently in the provided data, i.e. the observation 

with the highest frequency is known as the mode of data. The mode formulae 

provided below can be used to compute the mode for ungrouped data.  
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Mode of Ungrouped Data: Most repeated observation in dataset 

2. Measures of Dispersion 

If the variability of data within an experiment must be established, absolute 

measures of variability should be employed. These metrics often reflect 

differences in a data collection in terms of the average deviations of the 

observations. The most prevalent absolute measurements of deviation are 

mentioned below. In the following sections, we will look at the variability 

measures, their formulae in depth. 

 Range 

 Standard Deviation 

 Variance 

Range  

The range represents the spread of your data from the lowest to the 

highest value in the distribution. It is the most straightforward measure of 

variability to compute. To get the range, subtract the data set’s lowest and 

highest values. 

    Range = Highest value – Lowest value 

Standard Deviation 

Standard deviation (s or SD) represents the average level of variability 

in your dataset. It represents the average deviation of each score from the 

mean. The higher the standard deviation, the more varied the dataset is. 

To calculate standard deviation, follow these six steps: 

Step 1: Make a list of each score and calculate the mean. 

Step 2: Calculate deviation from the mean, by subtracting the mean from 

each score. 

Step 3: Square each of these differences. 

Step 4: Sum up all squared variances. 

Step 5: Divide the total of squared variances by N-1. 

Step 6: Find the square root of the number that you discovered. 

Variance 

Variance is calculated as average of squared departures from the 

mean. Variance measures the degree of dispersion in a data collection. The 

more scattered the data, the larger the variance in relation to the mean. To 
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calculate the variance, square the standard deviation. Symbol for variance 

is s2 

3. Measures of Frequency Distribution 

Datasets consist of various scores or values. Statisticians employ graphs 

and tables to summarize the occurrence of each possible value of a variable, 

often presented in percentages or numerical figures. Statisticians represent 

these frequency distributions through graphs or tables. 

Univariate Descriptive Statistics 

Univariate descriptive statistics focus on one thing at a time. We look 

at each thing individually and use different ways to understand it better. 

Programs like SPSS and Excel can help us with this. If we only look at the 

average (mean) of something, like how much people earn, it might not give 

us the true picture, especially if some people earn a lot more or less than 

others. Instead, we can also look at other things like the middle value 

(median) or the one that appears most often (mode). And to understand how 

spread out the values are, we use things like standard deviation and variance 

along with the range. 

Bivariate Descriptive Statistics 

When we have information about more than one thing, we can use 

bivariate or multivariate descriptive statistics to see if they are related. 

Bivariate analysis compares two things to see if they change together. Before 

doing any more complicated tests, it’s important to look at how the two 

things compare in the middle. Multivariate analysis is similar to bivariate 

analysis, but it looks at more than two things at once, which helps us 

understand relationships even better. 

Representations of Data in Descriptive Statistics 

Descriptive statistics use a variety of ways to summarize and present data 

in an understandable manner. This helps us grasp the data set’s patterns, 

trends, and properties. 

Frequency Distribution Tables: Frequency distribution tables divide data 

into categories or intervals and display the number of observations 

(frequency) that fall into each one. For example, suppose we have a class of 

20 students and are tracking their test scores. We may make a frequency 
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distribution table that contains score ranges (e.g., 0-10, 11-20) and displays 

how many students scored in each range. 

Graphs and Charts: Graphs and charts graphically display data, making it 

simpler to understand and analyze. For example, using the same test score 

data, we may generate a bar graph with the x-axis representing score ranges 

and the y-axis representing the number of students. Each bar on the graph 

represents a score range, and its height shows the number of students 

scoring within that range. These approaches help us summarize and 

visualize data, making it easier to discover trends, patterns, and outliers, 

which is critical for making informed decisions and reaching meaningful 

conclusions in a variety of sectors. 

Descriptive Statistics Applications 

Descriptive statistics are used in a variety of sectors to summarize, organize, 

and display data in a meaningful and intelligible way. Here are a few popular 

applications: 

Business and Economics: Descriptive statistics are useful for analyzing 

sales data, market trends, and customer behaviour. They are used to 

generate averages, medians, and standard deviations in order to better 

evaluate product performance, pricing strategies, and financial metrics. 

Healthcare: Descriptive statistics are used to analyze patient data such as 

demographics, medical histories, and treatment outcomes. They assist 

healthcare workers in determining illness prevalence, assessing treatment 

efficacy, and identifying risk factors. 

Education: Descriptive statistics are useful in education since they 

summarize student performance on tests and examinations. They assist 

instructors in assessing instructional techniques, identifying areas for 

improvement, and monitoring student growth over time. 

Market Research: Descriptive statistics are used to analyze customer 

preferences, product demand, and market trends. They enable businesses 

to make educated decisions about product development, advertising 

campaigns, and market segmentation. 

Finance and investment: Descriptive statistics are used to analyze stock 

market data, portfolio performance, and risk management. They assist 
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investors in determining investment possibilities, tracking asset values, and 

evaluating financial instruments. 

 

5.4. Index Numbers and Growth Rates 

We are a part of a fast-paced economy. Numerous changes in the size 

of the population, output, money supply, income, and price of commodities 

are taking place continuously in an ever-changing environment. Economic 

changes have their effects on the volume of economic activity, income and 

employment, general price level, and other factors. Most people are interested 

in learning how much their values have changed over time and how they have 

changed, and most values evolve. The index number helps in studying 

changes in consumption, production, imports, exports, cost of living, crimes, 

accidents, national income, business failures, and other phenomena. 

The index number was first constructed by an Indian Statistician, Carli in 

1764. It was used for the first time to compare the prices of the year 1750 

with that of the year 1500. An index number is a statistical tool for measuring 

changes in the magnitude of a group of related variables.  

An index number is used to display changes in a variable or group of 

related variables through time, space, or other factors. Comparisons can be 

made between elements like people, hospitals, schools, etc. It tracks changes 

in the value of variables such as the cost of living, the volume of production 

in various industries, the prices of a list of defined commodities, and so on. 

Also, as the index numbers are used to feel the pulse of the economy, they 

are also known as the Barometer of Economic Activity. 

5.4.1. Characteristics of Index Numbers 

The various features of Index Numbers are as follows: 

1. Specialized Averages:  

To compare two or more series, averages like mean, median and mode 

can be used. But averages cannot be used for comparison when series are 

composed of different types of items, or if two or more series are expressed in 

different units. Index numbers enable comparing changes in series. 

2. Expressed in Percentages: 
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The magnitude of a group’s changes is expressed in terms of 

percentages, which are independent of the measurement units. It helps in 

figuring out how two or more index numbers compare in various 

circumstances. Although, the % sign is never used. 

3. It assesses the impact of changes with respect to time or location: 

To compare changes over time, between places, and within categories, 

index numbers can be used. For example, the cost of living in two locations 

may differ at the same time, or the cost of living in one city can be compared 

over two time periods. 

4. It measures the change that cannot be measured directly: 

Its purpose is to examine changes in the effect of such factors that 

cannot be observed directly. For example, the cost of living cannot be 

measured directly. We can only study relative changes by examining 

variations in some related external factors. 

5.4.2. Uses of Index Numbers 

Practically, in all areas of economic activity, changes are measured 

using index numbers. It helps in recording changes in output, income, 

employment, business activities, productivity, etc. 

1. Measurement and Comparison of Changes in the Price Level: 

It is not possible to measure changes in the price level of two variables 

in absolute terms; therefore, index numbers provide a relative measure to the 

changes in the magnitude of a group of variables. It can be used to know the 

influence of changes in the value of money on different sections of society. It 

is possible to solve the problem of inflation or deflation in the system. 

2. Helps in Policy Formulation: 

An index number is an important tool for government or non-

government organizations in the following ways: In policy formulation, there 

is a need for a base or trend. With the index numbers, the trends of different 

phenomena can be studied. It can also be utilized in the formulation and 

planning of government and business policies. 

3. Acts as an Economic Barometer: 
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A barometer is an instrument that is used to measure atmospheric 

pressure. It indicates fluctuations in the general conditions of a country and 

measures the pulse of the economy. 

4. Helps in Studying Trade: 

Index numbers are useful in studying the trend of a series over a period 

of time. It helps in forecasting future trends which is crucial for any business 

or production activity’s future operations. Besides, it also aids in determining 

patterns in exports, imports, prices, and several other occurrences. For 

example, if someone is planning on opening up a new business, then by 

studying the trend of price, wages, income, etc., in different industries will 

help the businessman in planning the future course of action for the business. 

5. Measure Purchasing Power: 

Money’s worth is determined by purchasing power, and purchasing 

power is determined by commodity prices. Index numbers help find the 

intrinsic value of money as contrasted with its nominal value. It helps in 

establishing the nation’s wage policy. Besides, a change in the price of the 

commodity adversely affects the value of money. When the price level of a 

commodity rises, the purchasing power or value of money falls.  

6. Helps in Deflating Various Values: 

With price index numbers, it becomes easy to adjust the monetary 

figures of the different periods for changes in the price. For example, a 

country’s national income is calculated on the basis of the prices of the year 

mentioned in the question. However, the real change in the production level 

of goods and services cannot be revealed through the national income 

computed at the current year’s price. To know the real change, first, we have 

to adjust the figures for the price changes in different years. Making 

adjustments is possible only by using price index numbers. Besides, in case 

of rise in prices, the process of adjustment is known as deflating.  

5.4.3. Limitations of Index numbers 

The limitations of Index Numbers are as follows: 

1. Provides Relative Changes only: 

Index Numbers estimate relative changes only and cannot speak the truth as 

they are only approximate indicators. Besides, they represent the generalized 



113 
 

truth based on the overall average of the items. Therefore, it does not apply to 

specific units. 

2. Lack of Perfect Accuracy: 

Index numbers do not consider every item and are based on the sample items. 

Thus, in case of an inadequate sample or a sample selected through a faulty 

process, there will be inaccurate results. 

3. Ignores Qualitative Changes: 

Index numbers do not pay any attention to the qualitative changes in the 

product while constructing the price or production. An increase in the price 

possibly results from the improvement in the quality of the product. But it is 

neglected in the index numbers. 

4. Possibility of Manipulations: 

Index numbers can be created in a way that allows for manipulation. This 

manipulation can be made in a selection of a particular base year, a particular 

group of commodities, a specific set of prices, etc. 

5. Difference between purpose and method of Construction: 

When the index numbers are created for a specific purpose using a specific 

methodology, they are not suitable for all situations and uses. If they are 

employed for other reasons, they are bound to produce incorrect conclusions. 

 

5.5. Demand Function 

Demand refers to the quantity of a commodity the customer is willing and 

capable to purchase, at any given time and at each possible price. The above 

definition highlights essential components of demand: (i) Quantity of the 

commodity (ii) Willingness to buy (iii) Price of the commodity (iv) Period of 

time. Demand for a commodity can be expressed with respect to the 

individual (Individual Demand) or the entire market (Market Demand). 

The quantity of a good or service that a consumer is willing and capable to 

purchase at each possible price during a given time period is referred to as 

an Individual Demand. However, the quantity of goods or services that all 

consumers are willing and capable to purchase at every possible price within 

a given time period is referred to as Market Demand. 
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5.5.1. Demand Function 

The relationship between the quantity demanded of a particular commodity 

and the factors influencing it is expressed by the Demand Function. It can be 

with respect to an individual customer (Individual Demand Function) or all 

consumers in the market (Market Demand Function).  

1. Individual Demand Function 

The functional relationship between the individual quantity demanded of a 

particular commodity and the factors influencing it is defined as 

the Individual Demand Function. 

It is expressed as: 

   Dx = f (Px, Pr, Y, T, F) 

Where, 

Dx= Demand for Commodity x,  

Px= Price of the given Commodity x,  

Pr = Prices of Related Goods,  

Y = Income of the Consumer,  

T = Tastes and Preferences, and 

F = Expectation of Change in Price in the future. 

2. Market Demand Function 

The functional relationship between the market demand of a particular 

commodity and the factors influencing it is defined as the Market Demand 

Function. As earlier stated, market demand is influenced by all of the factors 

that influence individual demand. In addition to those factors, it is also 

influenced by population size and composition, season and weather, and 

income distribution. It is expressed as: Dx = f (Px, Pr, Y, T, F, Po, S, D) 

Where, 

Dx= Demand for Commodity x,  

Px= Price of the given Commodity x,  

Pr = Prices of Related Goods,  

Y = Income of the Consumer,  

T = Tastes and Preferences, and 

F = Expectation of Change in Price in the future. 

Po= Size and Composition of the population,  
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S = Season and Weather, and 

D = Distribution of Income. 

Demand Schedule 

A demand schedule is a tabular statement that shows different quantities of 

a commodity that are demanded at different prices, over the course of a 

particular time period. It shows the association between the quantity 

demanded and the price of the commodity. A demand schedule can be created 

for both individual buyers and the entire market.  

Therefore there are two types of demand schedules: 

1. Individual Demand Schedule 

2. Market Demand Schedule 

1. Individual Demand Schedule 

The tabular statement that shows different quantities of a commodity that a 

consumer is willing and capable to purchase at different levels of prices during 

a given time period is referred to as the Individual Demand Schedule. 

2. Market Demand Schedule 

The tabular statement that shows different quantities of a commodity that all 

the consumers are willing and capable to purchase at different levels of prices 

during a given time period is referred to as the Market Demand Schedule. It 

is the aggregate of all individual demand schedules at all prices. The formula 

for the market demand schedule is: 

     Dm = DA+DB+……. 

Where, 

Dm is the market demand, and  

DA+DB …… are the individual demands of Household A, Household B, and so 

on. 

5.5.2. Consumption Function 

The functional relationship between consumption and national income is 

known as Consumption Function. It was introduced by John Maynard Keynes 

and represents the willingness of households to purchase goods and services 

at a given income level during a given period of time. It is represented as C = 

f(Y); where C = Consumption, Y = National Income and f = Functional 

Relationship. The consumption function is a psychological concept that 
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shows consumption levels at different income levels in an economy. Besides, 

it is influenced by subjective factors like consumer habits, preferences, etc.  

Consumption Function is based on the Psychological Law of Consumption 

introduced by Keynes. The Psychological Law of Consumption states three 

main things: 

Even at zero income level, there is minimum consumption, i.e., autonomous 

consumption which is required for the survival needs of people. 

Consumption increases with the increase in income. 

The rate at which income increases is more than the rate of increase in 

consumption. 

5.5.3. Production Function 

Production function is a concept in economics that explains the 

relationship between physical output and input. Output refers to the number 

of goods or services produced in a given time period. Input, on the other hand, 

is the number of resources or materials that are used to produce output. 

While production is simply the process of creating goods and services for 

consumption, production function is the concept explaining the quantitative 

relationship between input and output. There are four main components of 

the production function.  

Types of Production Function 

 Short Run Production Function and Long Run Production Function are 

two types of production function. 

 Short run production function is the relationship between the specific 

variable input and quantity of output.  

 In the short run production function, only one factor is variable, while 

others remain fixed.  

 Long run production function explains the relationship between all 

inputs and the quantity of output.  

 In the long run production function, all factors of production, or inputs 

are variable.   

Total Product, Marginal Product, Average Product 

 Total Product refers to the total amount of goods and services produced 

in a given period of time within a given input. 
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 Marginal Product is the quantity of total goods and services when an 

additional unit of the variable factor is used.  

 Average Product refers to the total product per unit of variable factors 

or input.  

 The relationship between total product and marginal product is: 

 An increase in total product at an increasing rate results in an increase 

in marginal product. 

 The increase of total product at a diminishing rate causes the marginal 

product to decrease.  

 Finally, as the total product begins to decrease, the marginal product 

falls and becomes negative.  

 The relationship between average product and marginal product can be 

explained as: 

 When the average product is greater than the marginal product, the 

average product increases. 

 As the marginal product becomes more than the average product, the 

average product decreases. 

 As both marginal and average product fall, the marginal product falls 

at a greater rate and eventually becomes negative, while average 

product remains positive. 

5.6. Demand for and supply of money 

The law of supply and demand combines two fundamental economic 

principles describing how changes in the price of a resource, commodity, or 

product affect its supply and demand. As the price increases, supply rises 

while demand declines. Conversely, as the price drops supply constricts while 

demand grows. Levels of supply and demand for varying prices can be plotted 

on a graph as curves. The intersection of these curves marks the equilibrium, 

or market-clearing price at which demand equals supply, and represents the 

process of price discovery in the marketplace. 

5.6.1. Law of Demand 

The law of demand holds that demand for a product changes inversely to its 

price, all else being equal. In other words, the higher the price, the lower the 

level of demand. 
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Because buyers have finite resources, their spending on a given product or 

commodity is limited as well, so higher prices reduce the quantity demanded. 

Conversely, demand rises as the product becomes more affordable. As a 

result, demand curves slope downward from left to right, as in the chart 

below. Changes in demand levels as a function of a product's price relative to 

buyers' income or resources are known as the income effect. 

Naturally, there are exceptions. One is Giffen goods, typically low-priced 

staples also known as inferior goods. Inferior goods are those that see a drop 

in demand when incomes rise because consumers trade up to higher-quality 

products. But when the price of an inferior good rises and demand goes up 

because consumers use more of it in place of costlier alternatives, 

the substitution effect turns the product into a Giffen good. At the opposite 

end of the income and wealth spectrum, Veblen goods are luxury goods that 

gain in value and consequently generate higher demand levels as they rise in 

price because the price of these luxury goods signals (and may even increase) 

the owner's status. Veblen goods are named for economist and 

sociologist Thorstein Veblen, who developed the concept and coined the term 

"conspicuous consumption" to describe it. 

5.6.2. Law of Supply 

The law of supply relates price changes for a product with the quantity 

supplied. In contrast with the law of demand the law of supply relationship is 

direct, not inverse. The higher the price, the higher the quantity supplied. 

Lower prices mean reduced supply, all else held equal. Higher prices give 

suppliers an incentive to supply more of the product or commodity, assuming 

their costs aren't increasing as much. Lower prices result in a cost 

squeeze that curbs supply. As a result, supply slopes are upwardly sloping 

from left to right. As with demand, supply constraints may limit the price 

elasticity of supply for a product, while supply shocks may cause a 

disproportionate price change for an essential commodity. 

5.6.3. Equilibrium Price 

Also called a market-clearing price, the equilibrium price is the price at 

which demand matches supply, producing a market equilibrium acceptable 

to buyers and sellers. 
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At the point where an upward-sloping supply curve and a downward-sloping 

demand curve intersect, supply and demand in terms of the quantity of the 

goods are balanced, leaving no surplus supply or unmet demand. The level of 

the market-clearing price depends on the shape and position of the respective 

supply and demand curves, which are influenced by numerous factors.  

5.7. Correlation 

The previous statistical approaches (such as central tendency and 

dispersion) are limited to analysing a single variable or statistical analysis. 

This type of statistical analysis in which one variable is involved is known 

as Univariate Distribution. However, there are instances in real-world 

situations where distributions have two variables like data related to income 

and expenditure, prices and demand, height and weight, etc. The distribution 

with two variables is referred to as Bivariate Distribution. It is necessary to 

uncover relationships between two or more statistical series. Correlation is a 

statistical technique for determining the relationship between two variables. 

A statistical tool that helps in the study of the relationship between two 

variables is known as Correlation. It also helps in understanding the 

economic behaviour of the variables. 

5.7.1. Significance of Correlation 

 It helps determine the degree of correlation between the two variables 

in a single figure. 

 It makes understanding of economic behaviour easier and identifies 

critical variables that are significant.  

 When two variables are correlated, the value of one variable can be 

estimated using the value of the other. This is performed with the 

regression coefficients. 

 In the business world, correlation helps in taking decisions. The 

correlation helps in making predictions which helps in reducing 

uncertainty. It is so because the predictions based on correlation are 

probably reliable and close to reality. 
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Based on the direction of change in the value of two variables, correlation 

can be classified as: 

1. Positive Correlation: 

When two variables move in the same direction; i.e., when one increases the 

other also increases and vice-versa, then such a relation is called a Positive 

Correlation. For example, Relationship between the price and supply, income 

and expenditure, height and weight, etc. 

 2. Negative Correlation: 

When two variables move in opposite directions; i.e., when one increases the 

other decreases, and vice-versa, then such a relation is called a Negative 

Correlation. For example, the relationship between the price and demand, 

temperature and sale of woollen garments, etc. 

Based on the ratio of variations between the variables, correlation can be 

classified as: 

1. Linear Correlation:  

When there is a constant change in the amount of one variable due to 

a change in another variable, it is known as Linear Correlation. This term is 

used when two variables change in the same ratio. If two variables that change 

in a fixed proportion are displayed on graph paper, a straight- line will be used 

to represent the relationship between them. As a result, it suggests a linear 

relationship. 

2. Non-Linear (Curvilinear) Correlation: 

When there is no constant change in the amount of one variable due to 

a change in another variable, it is known as a Non-Linear Correlation. This 

term is used when two variables do not change in the same ratio. This shows 

that it does not form a straight-line relationship. For example, the production 

of grains would not necessarily increase even if the use of fertilizers 

is doubled. 

Based on the number of variables involved, correlation can be classified as: 

1. Simple Correlation: 

Simple correlation implies the study between the two variables only. For 

example, the relationship between price and demand, and the relationship 

between price and money supply. 
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2. Partial Correlation: 

Partial correlation implies the study between the two variables keeping other 

variables constant. For example, the production of wheat depends upon 

various factors like rainfall, quality of manure, seeds, etc. But, if one studies 

the relationship between wheat and the quality of seeds, keeping rainfall and 

manure constant, then it is a partial correlation. 

3. Multiple Correlation: 

Multiple correlation implies the study between three or more three variables 

simultaneously. The entire set of independent and dependent variables is 

studied simultaneously. For example, the relationship between wheat output 

with the quality of seeds and rainfall. 

5.7.2. Degree of Correlation 

The degree of correlation is measured through the coefficient of correlation. 

The degree of correlation for the given variables can be expressed in the 

following ways: 

1. Perfect Correlation: 

If the relationship between the two variables is in such a way that it varies in 

equal proportion (increase or decrease) it is said to be perfectly correlated. 

This can be of two types: 

Positive Correlation: When the proportional change in two variables is in 

the same direction, it is said to be positively correlated. In this case, the 

Coefficient of Correlation is shown as +1. 

Negative Correlation: When the proportional change in two variables is in 

the opposite direction, it is said to be negatively correlated. In this case, the 

Coefficient of Correlation is shown as -1. 

2. Zero Correlation: 

If there is no relation between two series or variables, it is said to have zero or 

no correlation. It means that if one variable changes and it does not have any 

impact on the other variable, then there is a lack of correlation between them. 

In such cases, the Coefficient of Correlation will be 0. 

3. Limited Degree of Correlation: 
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 There is a situation with a limited degree of correlation between perfect 

and absence of correlation. In real life, it was found that there is a 

limited degree of correlation.  

 The coefficient of correlation, in this case, lies between +1 and -1. 

 Correlation is limited negative when there are unequal changes in the 

opposite direction. 

 Correlation is limited and positive when there are unequal changes in 

the same direction. 

 The degree of correlation can be low (when the coefficient of correlation 

lies between 0 and 0.25), moderate (when the coefficient of correlation 

lies between 0.25 and 0.75), or high (when the coefficient of correlation 

lies between 0.75 and 1). 

5.8. Regression Analysis 

Regression Analysis is a supervised learning analysis where supervised 

learning is the analyzing or predicting the data based on the previously 

available data or past data. For supervised learning, we have both train data 

and test data. Regression analysis is one of the statistical methods for the 

analysis and prediction of the data. Regression analysis is used for predictive 

data or quantitative or numerical data. In R Programming 

Language Regression Analysis is a statistical model which gives the 

relationship between the dependent variables and independent variables. 

Regression analysis is used in many fields like machine learning, artificial 

intelligence, data science, economics, finance, real estate, healthcare, 

marketing, business, science, education, psychology, sports analysis, 

agriculture, and many more. The main aim of the regression analysis is to 

give the relationship between the variables, nature, and strength among the 

variables, and make predictions based on the model. 

5.8.1. Types of regression analysis 

We know that the regression analysis is the statistical technique that gives 

the relationship between the dependent and independent variables. There are 

many types of regression analysis. Let us discuss the each type of regression 

analysis in detail. 

1. Simple Linear Regression 
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It is one of the basic and linear regression analysis. In this simple linear 

regression there is only one dependent and one independent variable. This 

linear regression model only one predictor. This linear regression model gives 

the linear relationship between the dependent and independent variables. 

Simple linear regression is one of the most used regression analysis. This 

simple linear regression analysis is mostly used in weather forecasting, 

financial analysis, market analysis. It can be used for the predicting 

outcomes, increasing the efficiency of the models, make necessary measures 

to prevent the mistakes of the model. 

The mathematical equation for the simple linear regression model is shown 

below. 

y=ax+b 

Where y is a dependent variable 

x is a independent variable 

a, b are the regression coefficients 

2. Multiple Linear Regression 

Multiple linear regression analysis gives the relationship between the two or 

more independent variables and a dependent variable. Multiple linear 

regression can be represented as the hyper plane in multidimensional space. 

It is also a linear type regression analysis. It is almost similar to the linear 

regression but the major difference is the number of independent variables 

are different. Multi linear regression analysis is used in the fields of real 

estate, finance, business, public healthcare etc. 

The mathematical equation for the multiple linear regression is shown below. 

y=a0x1+a1x2+a2x3+….+b 

where y is a dependent variable 

X1, x2, x3 ….are the independent variables 

a0, a1, a2… are the constants /coefficients of independent variables / partial 

regression coefficients b is the intercept. 

3. Polynomial Regression 

Polynomial regression analysis is a non-linear regression analysis. 

Polynomial regression analysis helps for the flexible curve fitting of the data, 

involves the fitting of polynomial equation of the data. Polynomial regression 
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analysis is the extension of the simple linear regression analysis by adding 

the extra independent variables obtained by raising the power. 

The mathematical expression for the polynomail regression analysis is shown 

below. 

y=a0+a1x+a2x^2+………..+anx^n 

where y is dependent variable 

x is independent variable 

a0, a1, a2 are the coefficients of independent variable. 

4. Exponential Regression 

Exponential regression is a non-linear type of regression. Exponential 

regression can be expressed in two ways. Let us discuss the both type of 

exponential regression types in detail with example. Exponential regression 

can be used in finance, biology, physics etc. fields. Let us look the 

mathematical expression for the exponential regression with example. 

y=ae^(bx) 

where y is dependent variable 

x is independent variable 

a,b are the regression coefficients. 
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Check Your Progress: 

Q.No                                        Short Questions                                           LOCF Mapping     

1. 

 

2. 

 

3. 

 

4. 

 

5. 

Explain how MS Excel can be used to calculate mean, median, 

mode in descriptive statistics. 

Describe the concept of standard deviation and variance and 

explain how excel functions can be used to compute them. 

Assess the concept of index numbers and illustrate how excel 

can be used to calculate simple price index numbers. 

Examine the importance of growth rate calculations in 

economics and explain how excel formulas help compute them. 

Define correlation and explain how excel can be used to 

measure the relationship between two variables. 

K3 

 

K2 

 

K4 

 

K4 

 

K2 

CO2 

 

CO2 

 

CO3 

 

CO3 

 

CO4 

PO1 

 

PO1 

 

PO2 

 

PO3 

 

PO4 

Q.No                                        Essay Type Questions                                LOCF Mapping 

1. 

 

2. 

 

3. 

 

4. 

 

5. 

Examine the descriptive statistics tools in excel and demonstrate 

how mean, median and mode, variance are calculated. 

Describe the production and consumption function and evaluate 

how excel can help analyze economic relationships. 

Elaborately discuss the regression analysis in technique how 

excel can be used to predict economic outcomes. 

Design excel spreadsheet model to analyze demand and supply 

data, including graphs and statistical calculations. 

Identify the concept of correlation analysis and explain how 

excel functions and scatter plots help interpret relationships 

between variables. 

K3 

 

K5 

 

K5 

 

K6 

 

K3 

CO2 

 

CO3 

 

CO4 

 

CO5 

 

CO4 

PO1 

 

PO2 

 

PO4 

 

PO3 

 

PO4 
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Course Outcomes Programme 

Outcomes 

CO On completion of this course, students will   

1 Understand basic components of Computer and its 

functions. 
PO1, PO3,PO8 

2 Gain Knowledge of MS Office. PO3,PO8 

3 Outline data processing techniques of MS Excel. PO2,PO3,PO8 

4 Understand basic Operation in MS Excel. PO1,PO2,PO8 

5 Apply MS Excel in Statistics and Economics. PO2,PO3,PO8 

 

Textbooks 

 

1 Hem Chand Jain   and H.N.Tiwari (2019) Computer Applications In Business 

,5thEdition  Taxmann Publication. 

2 Dhanasekaran.K( 2010) Computer Applications In Economics Vrinda 

Publications. 

3 Asthana and Braj Bhushan (2007):Statistics for Social Sciences (with SPSS 

Applications). 

4. Dan Kookin, “Word for Dummies”, Wiley, 2021 

5. Joseph Muller, “Statistical Analysis with Excel For Dummies”, Wiley, 2008 

 

Reference Books 

 

1. Oscar Afonso, Paulo B. Vasconcelos, Computational Economics: A Concise 

Introduction, Routledge; 1stEdition 

2. Alexis Leon and Mathews Leon; (2001), Introduction to Computers with Ms-

Office 2000.McGraw Hill Education 

3. Greg Harvey, PhD, (2007) Microsoft Office Excel 2007 For Dummies, Wiley 

Publishing. 

4. Kerns (1992) Essentials of Microsoft Windows, Word and Excel, Prentice Hall 

5. Kavindra Kumar Singh (2014) Computer Applications in ManagementDreamTech 

 

Web Resources 

 

1. https://www.excel-easy.com/basics.html 

2. https://excelchamps.com/excel-basics/ 

3. https://edu.gcfglobal.or/en/topics/excel/ 

4. https://trumpexcel.com/learn-excel/ 

5. https://www.simplilearn.com/learn-ms-excel-free-training-course-skillup 

https://www.excel-easy.com/basics.html
https://edu/
https://www.simplilearn.com/learn-ms-excel-free-training-course-skillup
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Mapping with Programme Outcomes: 

 
 PO 1 PO 2 PO 3 PO 4 PO 5 PO 6 PO 7 PO 8 

CO 1 3 3 3 3 3 3 3 3 

CO 2 3 3 3 3 3 3 3 3 

CO 3 3 3 3 3 3 3 3 3 

CO 4 3 3 3 3 2 3 3 3 

CO 5 3 2 2 3 3 3 3 3 

Weightage 15 14 14 15 14 15 15 15 

Weighted 

percentage of 

course 

contribution to 

POS 

3.0 2.8 2.8 3.0 2.8 3.0 3.0 3.00 

                

 S-Strong-3 M-Medium-2   L-Low-1 

Level of Correlation between PSO’s and CO’s 

CO /PO PSO1 PSO2 PSO3 PSO4 PSO5 

CO1 2 2 2 3 3 

CO2 2 2 2 3 3 

CO3 2 2 2 3 3 

CO4 2 2 2 3 3 

CO5 3 3 3 3 3 

Weightage 11 11 11 15 15 

Weighted percentage 

of Course Contribution 

to PSOs 

2.2 2.2 2.2 3 3 

 
Strong-3 M-Medium-2   L-Low-1 
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